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Introduction

Important Notice

 The contents of this document and the specifications of this product are subject to change without notice.

 Brother reserves the right to make changes without notice in the specifications and materials contained 
herein and shall not be responsible for any damages (including consequential) caused by reliance on the 
materials presented, including but not limited to typographical and other errors relating to the publications.

 Screen images in this document may differ depending on your computer's operating system, your product 
model and, the software version.

 Before using the P-touch labeling system, make sure you read all documents included with the P-touch 
labeling system for information about safety and proper operation.

 Not all options and the consumables such as TZe, HGe tape, FLe label, and HSe tube are available in all 
countries.

 The available options and supplies may vary depending on the country.

Available Manuals

Visit the Brother support website at support.brother.com and click Manuals on your model page to download 
the latest manuals.

1 Printed manual in the box
2 PDF manual on the Brother support website

Product Safety Guide 1 This guide provides safety information; read it before you use the 
P-touch labeling system.

Quick Setup Guide 1 This guide provides basic information about using the P-touch 
labeling system along with troubleshooting tips.

User's Guide 2 This guide provides additional information about the P-touch labeling  
settings and operations, network connection and settings, 
troubleshooting tips, and maintenance instructions.

https://support.brother.com/
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Symbols Used in This Guide

The following symbols are used throughout this guide:

Tells you what to do to avoid the risk of injury.

Tells you about procedures you must follow to avoid minor personal injury or 
damage to the P-touch labeling system.

Important Indicates information or directions that should be followed. Ignoring them may result 
in damage, or failed operations.

Note Indicates notes that provide information or directions that can help you better 
understand and use the product more efficiently.

WARNING
CAUTION
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IMPORTANT NOTE

 This product is approved for use in the country of purchase only. Do not use this product outside the 
country of purchase as it may violate the wireless telecommunication and power regulations of that 
country.

 Not all models are available in all countries.

©2016 Brother Industries, Ltd. All rights reserved.
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General Description 1

Front/Back 1

 Front
 

 Back
 

1 Handle

2 Cover Open Button

3 Top Cover

4 Tape Exit Slot

5  (Label) Indicator

6  (Battery) Indicator

7  (Power) Button

8  (Feed and Cut) Button

9  (Wi-Fi) Button

10 Keyboard LCD Unit

11 Keyboard LCD Unit Interface Outlet

12 Cable Holder(holder for the Keyboard LCD Unit Cable)

13 USB Port

14 AC Adapter Outlet

Setting Up the P-touch Labeling System 1

1

2

3 4 5
6
7
8
9

10

13
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1
Inside 1

 

1 Accessory Storage Compartment
Use this space to store TZe Tape Cassettes and the AC Adapter.

2 Coin Cell Battery Holder

3 Tape Cassette Compartment

4 Print Head

5 Tape Cutter Unit

6 Tape Exit Slot

1

2

6

3

4

5
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1
Attaching the Keyboard LCD Unit 1

a Slide the cover on the bottom of the Keyboard LCD Unit to remove it, connect the Keyboard LCD Unit 
Cable, and then install the cover.

b Connect the USB Cable on the Keyboard LCD Unit to the Keyboard LCD Unit Interface Outlet on the 
side of the P-touch labeling system.
 

Note
• When you turn on the P-touch labeling system, the Keyboard LCD Unit is also turned on.

• The Keyboard LCD Unit can be installed on the P-touch labeling system by sliding it on the Top Cover (see 
Illustration A).

• When storing the keyboard LCD unit, turn it upside down and slide it on the top cover with the LCD facing 
down to prevent it from becoming dusty or dirty (see Illustration B).

• Use the Cable Holder to store the excess cable (see Illustration C).

 

   

  

 

Illustration A Illustration B Illustration C
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1
Connecting the Power Supply 1

Use the AD9100ESA (AC Adapter) for this P-touch labeling system. Connect the AC Adapter directly to the 
P-touch labeling system.

a Insert the plug on the AC Adapter Cord into the AC Adapter Outlet marked DC IN 24 V on the P-touch 
labeling system.

b Insert the plug on the Power Supply Cord into the AC Adapter.
 

1 AC Adapter

2 Power Supply Cord

c Insert the power supply plug into a standard AC Power Outlet.

Important
• Turn off the P-touch labeling system before disconnecting the AC Adapter.

• Do not pull or bend the AC Adapter cord or Power Supply Cord.

• After the power supply plug is inserted into the AC Power Outlet, it may take a few seconds until the   
(Power) Button is enabled.

 

Note
To safeguard and back up the P-touch labeling system memory, when the power supply is unplugged 
Brother recommends leaving the rechargeable Li-ion batteries (optional: PA-BT-4000LI) installed in the 
P-touch labeling system.

 

1
2
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1
Inserting a Tape Cassette 1

The TZe, HGe tape, FLe label, and HSe tube cassettes can be used in your P-touch labeling system.

Important
If the new Tape Cassette has a cardboard stopper, be sure to remove the stopper before inserting the 
cassette.
 

 

a Check that the end of the tape is not bent and that it passes through the Tape Guides. If it does not, 
gently push it through the Tape Guides, as shown in the illustration.
 

1 End of tape

2 Tape Guides (The actual shape may be different depending on the tape width.)

b Press the Cover Open Button to open the Top Cover.

c Carefully insert the Tape Cassette into the Tape Cassette Compartment with the end of the tape facing 
the P-touch labeling system Tape Exit Slot, then push down evenly until the Tape Cassette is installed 
correctly.
 

1 Tape Exit Slot

1

2 2

1

1
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1
Important

• When inserting the Tape Cassette, make sure that the tape and ink ribbon do not catch on the Print Head.

• Make sure that there is no slack in the tape. Otherwise, the tape may catch on the protrusion (2) and 
become bent or wrinkled, causing the tape to jam. To fix the slack in the tape, refer to the illustration in 
step a and pull the tape out of the Tape Guides.

• When removing the Tape Cassette, make sure that the tape does not catch on the protrusion (2).
 

 

d Close the Top Cover.

Important
Store Tape Cassettes in a cool, dark location, away from direct sunlight and high temperature, high 
humidity, or dusty locations. After opening the sealed package, insert the Tape Cassette as quickly as 
possible.

 

Turning Power On/Off 1

To Power On: 

Press the  (Power) Button to turn on the P-touch labeling system. The  (Power) indicator lights in green.

Note
When the P-touch labeling system is turned on for the first time, the language selection screen appears. 
Select the language using the  or  key. The language setting can also be changed later (for more 
information, see Setting Language and Unit on page 182).

 

To Power Off: 

Press and hold the  (Power) Button again to turn off the P-touch labeling system. The  (Power) indicator 
may light in orange until the power is off.

Important
When turning off the P-touch labeling system, do NOT remove the battery or disconnect the AC Adapter 

until the  (Power) indicator turns off.
 

2
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1
Feeding Tape 1

Important
• Be sure to feed tape to remove any slack in the tape and ink ribbon after inserting the Tape Cassette.

• Do not pull the label when the P-touch labeling system is ejecting it from the Tape Exit Slot. Doing 
so will cause the ink ribbon to be discharged with the tape. The tape may no longer be functional after the 
ink ribbon discharges.

• Do not block the Tape Exit Slot during printing or when feeding tape. Doing so will cause the tape to jam.
 

Press the Esc key to exit or cancel either function.

Feed and Cut 1

The Feed and Cut function feeds approximately 0.88" (22.3 mm) of blank tape, and then cuts the tape.

a Press the  (Feed and Cut) Button.
[Feed & Cut?] appears on the LCD.

b Select [Feed & Cut] using the  or  key, and then press the OK or Enter key. The message [Feeding 
Tape... Please Wait] appears while the tape is fed, and then the tape is cut.

Feed Only 1

This function ejects the tape approximately 0.88" (22.3 mm), resulting in a blank label sticking out of the Tape 
Cassette. This action is recommended when using Fabric tapes, which should be cut with scissors.

a Press the  (Feed and Cut) Button.
[Feed & Cut?] appears on the LCD.

b Select [Feed Only] using the  or  key, and then press the OK or Enter key. The message [Feeding 
Tape... Please Wait] appears while the tape is fed.
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2

2
Keyboard LCD Unit Description 2

Key Names and Functions 2

 

1 Home
Returns to the Home screen to select a menu.

2 Format
Sets characters and attributes.

3 PF (Programmable Function)
Selects programmable function.

4 Clear
Clears all text entered, or all text and current settings.

5 Save
Saves the created data in the file memory.

6 Preview
Displays an image of the label that will be printed in the set layout.

7 Cancel
Deletes the print job.

8 Print/Print Options
 Prints the current data onto the tape.
 Prints multiple copies or changes the print settings when used in combination with the Shift key.

9 BS (Backspace)
Deletes the character to the left of the cursor.

10 Next
Creates the next page.

11 Enter
Adds a new line when entering text.
Selects the displayed option.

Printing a Label Using the P-touch 
Labeling System Keyboard 2

5 6 7

8
9
10
11
12
13

2 43

23
22
21
12

14151617181920

1
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12 Shift
Enters uppercase letters or symbols when used in combination with the letter keys or number keys.

13 OK
Selects the displayed option.

14 Cursor (    )
Moves the cursor in the direction of the arrow.

15 Esc (Escape)
Cancels the current command and returns the display to the data entry screen or the previous step.

16 Space
 Inserts a blank space.
 Returns a setting to the default value.

17 Accent
Selects and enters an accented character.

18 Symbol
Selects and enters a symbol from the list of available symbols.

19 Serialize/Adv. Serialize
Sets serialized numbers.

20 Insert
Inserts a time stamp, barcode, database, or transferred symbol.

21 Caps
Turns the Caps mode on and off.

22 Tab
Inserts a tab.

23 Letter
 Enters letters or numbers.
 Enters uppercase letters or symbols when used in combination with the Caps or Shift key.
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2

LCD 2

 Home Screen
 

1 Auto Format (Templates)
Specifies the label format from the preset templates.

2 Create Label
Displays the label creation screen.

3 Auto Format (Block Layouts)
Specifies the label format from the preset layouts.

4 File
Retrieves data that is saved in the file memory.

5 Cable Label
Specifies the label type from the following seven types: Faceplate/Cable Wrap/Cable Flag/Patch 
Panel/Punch-Down Block/Die-cut Flag/Inverted Label.

6 Transferred Templates
Retrieves data that was transferred from a computer.

7 Settings
Specifies various settings for the P-touch labeling system.

8 Register Programmable Function
Registers, deletes, and renames programs.

9 Wireless Connection

The left icon indicates the status of the Wi-Fi® connection. The right icon indicates the status of the 
Wireless Direct connection.

10 Battery Level
Indicates the remaining battery level. It appears only when using the rechargeable Li-ion battery.

Connected in Wi-Fi mode

Disconnected from Wi-Fi mode

Wireless Direct mode ON

(Blinking)
Connecting using the Setup Wizard

(Off) Wireless connection OFF

 - Full  - Low  - Charging

 - Half  - Empty

4

3

6

5

2

1

7

8

109
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2

 Label Creation Screen
 

1 Caps mode
Indicates that the Caps mode is on.

2 Style Guidance
Indicates the current font (A), character size (B), character width (C), character style (D), line (E), 
frame (F), and alignment (G) settings.

3 Layout Guidance
Indicates the orientation, layout, separator, reverse, and repeated text settings. The displayed items 
vary according to the selected label type.

4 Block Number
Indicates the block number.

5 Line Number
Indicates the line number within the label layout.

6 Page Separator Line
Indicates the end of one page and the beginning of the next page.

7 Block Separator Line
Indicates the end of a block.

8 Enter/Return Symbol
Indicates the end of a line of text.

9 Cursor
Indicates the current data input position. Characters are entered to the left of the cursor.

10 Wireless Connection
Indicates the current status of the wireless connection. For more information, see Wireless Connection 
in the Home Screen section.

11 Tab Length Setting
Indicates the set tab length.

12 Tape Size
Indicates the tape size as follows for the text entered: Tape width × Label length. If the label length has 

been specified,  also appears on the right side of the tape size.

8

7

64

5

1

2

9

A B C D E F G 3

1110 12 13
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13 Battery Level
Indicates the remaining battery level. It appears only when using the rechargeable Li-ion battery. For 
more information, see Battery Level on page 11 in the Home Screen section.
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Editing a Label 2

Press the Esc key to exit or cancel most functions, or to return to the previous step in a series.

Opening the Label Creation Screen 2

 

1 Create Label

Labels are created using the label creation screen. To open the label creation screen, select [Create 
Label] in the Home screen using the , ,  or  key, and then press the OK or Enter key.

Entering Text from the Keyboard 2

Use your P-touch labeling system's keyboard in the same way as a standard computer keyboard.

Inserting Text 2

To insert additional text into an existing line of text, move the cursor to the character at the position where 
you want to start inserting text, and then enter the additional text. The new text is inserted at the position of 
the cursor.

Adding a New Line 2

A return mark appears at the end of the line and the cursor moves to the start of the new line.

1
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Important
• Maximum number of lines (Labels)

• 1.4" (36 mm) tape: 17 lines

• 0.94" (24 mm) tape: 13 lines

• 0.70" (18 mm) tape: 10 lines

• 0.47" (12 mm) tape: 6 lines

• 0.35" (9 mm) tape: 4 lines

• 0.23" (6 mm) tape: 3 lines

• 0.13" (3.5 mm) tape: 1 line

• Maximum number of lines (Heat shrink tubes)

• 0.93" (23.6 mm) tape: 12 lines

• 0.69" (17.7 mm) tape: 10 lines

• 0.46" (11.7 mm) tape: 6 lines

• 0.34" (8.8 mm) tape: 4 lines

• 0.23" (5.8 mm) tape: 2 lines
 

Deleting Text 2

Deleting One Character at a Time 2

To delete a character from an existing line of text, move the cursor to the right of the position where you want 
to start deleting text, and then press the BS (Backspace) key. The character to the left of the cursor is deleted 
each time you press the BS (Backspace) key.

Deleting All Text at Once 2

a Press the Clear key. The Clear options appear.
 

b Using the  or  key, select [Text Only] to delete all text while retaining the current format settings, 
or select [Text&Format] to delete all text and format settings.

Note
When you select [Text&Format], all text is cleared and the character attribute and cutting option settings 
are reset to the factory settings.
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c Press the OK or Enter key.
 

Using Text Reminder 2

When you enter a character, the P-touch labeling system retrieves all character sequences in its memory that 
start with that character and displays those character sequences.

Select the word you want using the  or  key, and then press the OK or Enter key to insert the selected 
word on the text line.

For example, if you enter "B", a mark appears on the screen if there is a character sequence beginning with 
"B" in the history. If you press the OK key, the P-touch labeling system displays a list of words beginning with 
the letter "B", such as "Brother".

To delete the text reminder memory, select [Settings] > [Text Reminder] > [Clear Memory] in the Home 
screen, and then press the OK or Enter key.

Note
• To display the entire word, press the  key, and to return to the list of words, press the  key.

• The factory setting is On.

• To turn Text Reminder Off, go to the Home screen,  select [Settings] > [Text Reminder] > [On/Off] 
in the Home screen, and then press the OK or Enter key.

• Text Reminder memory can store up to 99 words.
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Inserting and Deleting Tabs 2

To insert a tab into an existing line of text, move the cursor to the position where you want the tab, and then 
press the Tab key.

Tabs appear as a mark ( ) in the label creation screen.

To delete a tab from a label, position the cursor to the right of the tab mark ( ) on the label creation screen, 
and then press the BS (Backspace) key.

Changing the Tab Length 2

Edit tab length before inserting tabs into your text.

The tab length can be set to between 0.0" and 4.0" (0 mm and 100 mm).

a Press the Format key.

b Select [Tab Length] using the  or  key.

c Select the tab length using the  or  key, and then press the OK or Enter key.

Note
You can also set the tab length by typing in the tab length you want. To apply the setting, after typing in 
the tab length, press the OK or Enter key, and then press the OK or Enter key again.

 

Adding a New Block 2

To create a new block of text and lines, press the Shift and Enter keys. The text to the right of the cursor will 
be moved to the new block. In some label types, you can set the number of blocks when selecting the label 
type. You can create up to 99 new blocks. 
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Adding a New Page 2

Press the Next key to create a new page.  The cursor moves to the start of the new page. You can create up 
to 99 new pages.

Entering Accented Characters 2

The P-touch labeling system can display and print a set of accented characters, such as other 
language-specific characters. Accented characters are listed in the Appendix, see Accented Characters 
on page 218.

a Enter the character you want to change to an accented character.

Note
Caps mode can be used with the Accent function.

 

b Press the Accent key.
The selectable accented characters appear on the screen.

c Select the accented character using the  or  key, and then press the OK or Enter key.
The character you entered will change to the selected accented character.

Important
The order of accented characters displayed will differ depending on the selected LCD language.
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Entering Symbols 2

In addition to the symbols available on the keyboard, there are various symbols (including international, 

extended ASCII characters and transferred symbols 1) available with the Symbol function.

To enter a symbol, use the Symbol function (for more information, see Entering Symbols Using the Symbol 
Function on page 19).

Alternatively, press the Shift key and a key on the keyboard simultaneously to enter the symbol printed on 
the selected key’s upper-right corner.
1 A bitmap image of a user-created character that is not supplied with the P-touch labeling system.

Entering Symbols Using the Symbol Function 2

Symbols (excluding transferred symbols) are listed in the Appendix, see Symbols on page 216.

a Press the Symbol key. A list of symbol categories appears.

Note
The last symbol entered is selected in the displayed list.

 

b Select a symbol category using the  or  key, and then press the OK or Enter key.

c Select a symbol using the , ,  or  key, and then press the OK or Enter key.
The selected symbol is inserted into the line of text.

Note
When selecting a symbol:

• To return to the previous page, press the Shift key and Symbol key.

• To go to the next page, press the Symbol key.
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Entering Transferred Symbols 2

Important
Before using transferred symbols, transfer the images to the P-touch labeling system using P-touch 
Transfer Manager. For more information about using P-touch Transfer Manager, see How to Use P-touch 
Transfer Manager on page 129.

 

a Press the Insert key.

b Select [Transferred Symbols] using the  or  key, and then press the OK or Enter key.

c Select a transferred symbol using the  or  key, and then press the OK or Enter key.
The selected image is inserted into the line of text.

Note

• When selecting a symbol, press the Shift key and  key to go to the next page, and press the Shift key 
and  key to go to the previous page.

• The inserted transferred symbol appears as a mark ( ) in the label creation screen.

• To view the transferred symbol in the label creation screen, move the cursor to the mark ( ) and press 
the Insert key.

 

Using Symbol History 2

Create your personal category of symbols using [Symbol History].  [History] appears first when 
selecting the symbols to help you locate the symbols you want quickly.

Important
Transferred symbols cannot be added to [Symbol History].

 

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Symbol History] using the  or  key, and press the OK or Enter key.

c Select [On] to create your personal category using the  or  key, and then press the OK or Enter key.

d In the label creation screen, enter the symbol you want to add to your history by pressing the Symbol 

key, selecting a symbol category using the  or  key, pressing the OK or Enter key, selecting a symbol 
using the , ,  or  key, and then pressing the OK or Enter key.
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e Press the Symbol key.
[History] appears, including the symbol entered in step d.
 

Note
• Up to 30 symbols can be added to [History]. The oldest symbol will be deleted from the category when 

the symbols added to [History] exceed 30 symbols.

• To stop using [Symbol History], follow steps a and b above, and then select [Off] in the [Symbol 
History] screen in step c.

 

Entering a Serialized Label 2

Numerically serialized labels can be created. You can set the increment and count for the series. In the 
serialize mode, you can create a series of labels by incrementing one numeric character in the pattern. In the 
advanced serialize mode, you can select between Simultaneous or Group. Simultaneous mode creates a 
series of labels by incrementing two different numbers at the same time. Group mode creates a series of 
labels by allowing you to select two sequences in the pattern and increment them consecutively.

Serialize Mode 2

a Enter the text except the text that you want to serialize.
Example: To create labels 1A-A01, 1A-A02, 1A-A03, and 1A-A04, enter only "1A-A0".
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b Position the cursor where you want to insert serialized text, and then press the Serialize/Adv. Serialize 
key.
 

c Select [Type], [Format], [From], [To] and [Increased by] using the  or  key, and set the values 
using the  or  key.

Note
You can also set [From], [To] and [Increased by] by typing in the numbers you want.

 

Example: [Type]: Normal, [Format]: 000-999, [From]: 1, [To]: 4, and [Increased by]: 1
See the following Serialize Settings table (factory settings are shown in bold):

Attribute Value Description

Type Normal, Octal, Hex, 
Alphabet

Specifies the format of the serialized number from 
decimal, octal, hexadecimal, and alphabetic.

Format Normal 000-999, __0-999,   0-999 Specifies how the digits of the serialized numbers 
are aligned.

 000-***: Zeroes are used to align the digits.

 __0-***: Blank spaces are used to align the digits.

   0-***: The digits are not aligned.

Octal 000-777, __0-777,   0-777

Hex 000-FFF, __0-FFF,   0-FFF

Alphabet a-z, A-Z Specifies lower-case or upper-case characters.

From Normal 000-999 Specifies the starting text for the serialized numbers.

Octal 000-777

Hex 000-FFF

Alphabet a-z, A-Z

To Normal 000-999 Specifies the ending text for the serialized numbers.

Octal 000-777

Hex 000-FFF

Alphabet a-z, A-Z

Increased 
by

1-9 Specifies the increment for increasing the serialized 
numbers.
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d Press the OK or Enter key to display an image of the labels on the screen.

Example: 
 

Note
• Although the P-touch labeling system creates multiple pages of labels after you complete the serialize 

settings, you can select the pages and print only the pages you want. For more information, see Printing 
a Range of Pages on page 48.

• When you want to print multiple copies of the serialized labels, select [Serialize] or [Copy] for the 
printing order in [Settings] > [Print Order] in the Home screen.

• When creating labels with a serialized barcode, select the entered barcode, and then press the 
Serialize/Adv. Serialize key. For more information about barcodes, see Creating a Barcode Label 
on page 27.

 

Advanced Serialize Mode 2

Simultaneous 2

a Enter the text except the text that you want to serialize.
Example: To create labels 1A-A01, 1A-B02, 1A-C03, and 1A-D04, enter only "1A-0".
 

b Position the cursor where you want to insert the first serialized text (to the right of "0"), and then press 
the Shift and Serialize/Adv. Serialize keys. Select [Simultaneous] using the  or  key, and then 
press the OK or Enter key.
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c For the first serialized text, select [Type], [Format], [From], [To] and [Increased by] using the  or 
 key, set the values using the  or  key, and then press the OK or Enter key.

Note
You can also set [From], [To] and [Increased by] by typing in the numbers you want.

 

Example: [Type]: Normal, [Format]: 000-999, [From]: 1, [To]: 4, and [Increased by]: 1
See the Serialize Settings table in step c of Serialize Mode for more information.

d Position the cursor where you want to insert the second serialized text (to the left of "0"), and then press 
the OK or Enter key.
 

e For the second serialized text, select [Type], [Format], [From], and [Increased by] using the  or  
key, set the values using the  or  key, and then press the OK or Enter key.
Example: [Type]: Alphabet, [Format]: A-Z, [From]: A, and [Increased by]: 1
See the Serialize Settings table in step c of Serialize Mode for more information.

Note
Because the serialized number count is the same for the first serialized text and second serialized text, 
the value for [To] is set automatically.

 

f Press the OK or Enter key to display an image of the labels on the screen.

Example: 
 

Note
• Although the P-touch labeling system creates multiple pages of labels after you complete the serialize 

settings, you can select the pages and print only the pages you want. For more information, see Printing 
a Range of Pages on page 48.

• When you want to print multiple copies of the serialized labels, select [Serialize] or [Copy] for the 
printing order in [Settings] > [Print Order] in the Home screen.

• When creating labels with a serialized barcode, select the entered barcode, and then press the 
Serialize/Adv. Serialize key. For more information about barcodes, see Creating a Barcode Label 
on page 27.

 



Printing a Label Using the P-touch Labeling System Keyboard 

25

2

Group 2

a Enter the text except the text that you want to serialize.
Example: To create labels 1A-A01, 1A-A02, 1A-A03, 1A-A04, 1A-B01, 1A-B02, 1A-B03 and 1A-B04, 
enter only "1A-0".
 

b Position the cursor where you want to insert the first serialized text (to the right of "0"), and then press 
the Shift and Serialize/Adv. Serialize keys. Select [Group] using the  or  key, and then press the 
OK or Enter key.
 

c For the first serialized text, select [Type], [Format], [From], [To] and [Increased by] using the  or 
 key, set the values using the  or  key, and then press the OK or Enter key.

Example: [Type]: Normal, [Format]: 000-999, [From]: 1, [To]: 4, and [Increased by]: 1
See the Serialize Settings table in step c of Serialize Mode for more information.

d Position the cursor where you want to insert the second serialized text (to the left of "0"), and then press 
the OK or Enter key.
 

e For the second serialized text, select [Type], [Format], [From], [To] and [Increased by] using the  
or  key, set the values using the  or  key, and then press the OK or Enter key.
Example: [Type]: Alphabet, [Format]: A-Z, [From]: A, [To]: B, and [Increased by]: 1
See the Serialize Settings table in step c of Serialize Mode for more information.
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f Press the OK or Enter key to display an image of the labels on the screen.

Example: 

 

Note
• Although the P-touch labeling system creates multiple pages of labels after you complete the serialize 

settings, you can select the pages and print only the pages you want. For more information, see Printing 
a Range of Pages on page 48.

• When you want to print multiple copies of the serialized labels, select [Serialize] or [Copy] for the 
printing order in [Settings] > [Print Order] in the Home screen.

• When creating labels with a serialized barcode, select the entered barcode, and then press the 
Serialize/Adv. Serialize key. For more information about barcodes, see Creating a Barcode Label 
on page 27.

 

Note
Letters and numbers increase as shown below:

0 i 1 i 2 i 3... i 999 i 000 i 001 i 002 i 003...

A i B i C i D... i Z i A i B i C i D...

a i b i c i d... i z i a i b i c i d...
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Creating a Barcode Label 2

Use the barcode function to create labels with one dimensional barcodes for use with asset control tags, 
serialized number labels, and even POS and stock control systems.

Barcodes are listed in the Appendix, see Barcodes on page 229.

Note
• The P-touch labeling system is not designed exclusively for creating barcode labels. Always check that 

barcode labels can be read by the barcode reader.

• For best results, print barcode labels in black ink on white tape. Some barcode readers may not be able 
to read barcode labels created using colored tape or ink.

• Use the [Large] setting for [Width] whenever possible. Some barcode readers may not be able to read 
barcode labels created using the [Small] setting.

• Continuously printing a large number of labels with barcodes can overheat the Print Head, which may 
affect printing quality.

 

Setting Barcode Parameters and Entering Barcode Data 2

a Press the Insert key.

b Select [Bar Code] using the  or  key, and then press the OK or Enter key.
The [Bar Code] screen appears.

Note
Up to five barcodes can be entered on a label.

 

c Select an attribute using the  or  key, and then select the setting for that attribute using the  or  
key. (Factory settings are shown in bold.)

 Protocol: CODE39, CODE128, EAN-8, EAN-13, GS1-128 (UCC/EAN-128), UPC-A, UPC-E, I-2/5 
(ITF), CODABAR

Width: Small, Large

 Under#: On, Off

 C.Digit: Off, On

The check digit is available only for CODE39, I-2/5 and CODABAR protocols.

Note
Characters may not appear below the barcode even when [On] is selected for [Under#] depending on the 
width of the tape being used, the number of lines entered, or the current character style settings.

 

d Press the OK or Enter key to apply the settings.

Note
New settings are NOT applied unless you press the OK or Enter key.
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e Type in the barcode data.
Enter special characters in the barcode when using the CODE39, CODE128, CODABAR or GS1-128 
protocols. When not using special characters, go to step h.
 

f Press the Symbol key.
A list of characters available for the current protocol appears.

g Select a character using the  or  key, and then press the OK or Enter key to insert the character in 
the barcode data.
 

h Press the OK or Enter key to insert the barcode in the label.
The barcode appears on the label creation screen.
 

Note
To set the selected attribute as the default setting, press the Space key .

 

Editing and Deleting a Barcode 2

 To edit barcode parameters and barcode data, select the barcode, and then press the OK or Enter key. 
For more information, see Setting Barcode Parameters and Entering Barcode Data on page 27.

 To delete a barcode from a label, position the cursor to the right of the barcode mark or select the barcode, 
and then press the BS (Backspace) key.
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Using the Time Stamp Function 2

Add the time and date to your label using the Clock settings.

Clock Setting 2

Set the time and date in the [Set Clock] screen. After setting the time and date, you can add this information 
to your label using the [Time Stamp] function.

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Set Clock] using the  or  key, and then press the OK or Enter key.

c Set the year according to the current date using the  or  key. Move to the next parameter using the 

 or  key, and then set the parameter according to the current date and time using the  or  key. 
After you set all the parameters, press the OK or Enter key to apply the settings.

Note
• You can also set the time and date by typing in the numbers you want.

• The clock will activate from when the clock setting is applied.

• The Coin Cell Battery is used to back up the clock setting when the AC Adapter is unplugged.
 

Time & Date Format Setting 2

Select from various formats of the time and date to add to your label.

Time & Date formats are listed in the Appendix, see Time and Date on page 231.

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Time & Date Format] using the  or  key, and then press the OK or Enter key.

c Select [Date] or [Time] using the  or  key according to the item that you want to set. Select the format 

using the  or  key, and then press the OK or Enter key to apply the settings.

Note
The values for the date and time are used to display a sample setting. When a format is selected, the time 
and date set in the clock setting will appear in the selected format style.

 



Printing a Label Using the P-touch Labeling System Keyboard 

30

2

Time Stamp Setting 2

Insert a time stamp on your label using the following procedure.

Press the Insert key, select [Time Stamp] using the  or  key, and then press the OK or Enter key.

You can change the time stamp settings to display the time stamp in various formats. (Factory settings are 
shown in bold.)

 Timing

Select whether to print the date and time when you press the Insert key, select [Time Stamp] using the 
 or  key, and then press the OK or Enter key, or the date and time when you press the Print, OK or 

Enter key to add to your label.

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Time Stamp Setting] using the  or  key, and then press the OK or Enter key.

c Select [Timing] using the  or  key, select [Auto] or [Fixed] using the  or  key, and then 
press the OK or Enter key to apply the settings.

Note
When [Auto] is selected for the [Timing] setting and a clock icon is added to the text by pressing the 
Insert key, selecting [Time Stamp] using the  or  key, and then pressing the OK or Enter key, you 
can confirm the icon settings as follows. Position the cursor to the left of the clock icon, press the Insert 
key, select [Time Stamp] using the  or  key, and then press the OK or Enter key.
 

Attribute Setting Description

Timing Auto Press the Insert key, select [Time Stamp] using the  or  key, 
and then press the OK or Enter key; the current date and time (a 
future date and time or a past date and time when [Forward] is 
set) and a clock icon will be inserted where the cursor is 
positioned on the label creation screen.

When you press the Print, OK, or Enter key to print, the current 
date and time will be printed on the label where the date, time, and 
the clock icon are positioned on the label layout.

Fixed Press the Insert key, select [Time Stamp] using the  or  key, 
and then press the OK or Enter key; the current date and time will 
be inserted where the cursor is positioned on the label creation 
screen.

When you press the Print, OK, or Enter key to print, the date and 
time will be printed as shown on the label creation screen.
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 Format

Select which information to use when adding the date and time to your label.

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Time Stamp Setting] using the  or  key, and then press the OK or Enter key.

c Select [Format] using the  or  key, select the value for the setting using the  or  key, and 
then press the OK or Enter key to apply the settings.

 Forward

Select whether to use a future date and time, a past date and time, or the current date and time when 
[Timing] is set to [Auto].

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Time Stamp Setting] using the  or  key, and then press the OK or Enter key.

c Select [Forward] using the  or  key, select [On] using the  or  key, and then press the OK or 
Enter key.

d Select [Add] or [Reduce] using the  or  key, select the year, month, week, date, hour or minute 
using the  or  key, and then set the amount to increase or decrease from the currently set clock 
using the  or  key. Press the OK or Enter key to apply the settings.

Note
You can also set the date and time by typing in the numbers.

 

Attribute Setting Description

Format Date Prints only the date on the label.

Time Prints only the time on the label.

D&T Prints the date and time on the label.

T&D Prints the time and date on the label.

Attribute Setting Description

Forward Off Prints the current time and date.

On Increases or decreases the date and time according to the value 
selected in the [Forward] setting.
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Changing and Deleting the Time Stamp Settings 2

To change the [Time Stamp] settings, select the clock icon, and then press the OK or Enter key.

To delete a time stamp from a label, position the cursor to the right of the clock icon or select the clock icon, 
and then press the BS (Backspace) key.

Setting Character Attributes 2

Setting Character Attributes by Label 2

Using the Format key, select a font and apply size, width, style, line, and alignment attributes. Character 
Attribute options are listed in the Appendix, see Character Attributes on page 219.

a Press the Format key.
The [Font] dialog box appears.
 

b Select an attribute using the  or  key.

c Select the setting for that attribute using the  or  key, and then press the OK or Enter key to apply 
the settings.

Note
New settings are NOT applied unless you press the OK or Enter key.

 

Note
• To set the selected attribute as the default setting, press the Space key.

• Small characters may be difficult to read when certain styles are applied (for example, Shadow + Italic).

• Depending on the label type, you cannot change the Format setting. In this case,  appears on the left 
side of the dialog box.

 

Setting Character Attributes by Each Line 2

When a label consists of two or more lines of text, you can set different character attributes (font, size, width, 
style, line and alignment) for each line.
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Move the cursor to the line you want to modify using the , ,  or  key. Next, press the Shift and Format 
keys to display the setting dialog box. (  on the dialog box indicates that you are now setting the attributes 
for that specific line only.)
 

Important
• When different attribute values are set for each line, the value appears as ***** when you press the Format 

key. When you change the setting on this screen using the  or  key, the same change is applied to all 
lines of the label.

• When different attribute values are set for each line, the settings of the line where the cursor is positioned 
in the label creation screen appear at the top of the screen.

 

Setting Frames 2

Select the frame of the label using the Format key. Frames are listed in the Appendix, see Frames 
on page 222.

a Press the Format key.

b Select [Frame] using the  or  key.
 

c Select a frame using the  or  key, and then press the OK or Enter key.
The selected frame is inserted.
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Note
• If you press the Preview key when selecting a frame, the Frame List screen appears.  Select a frame. 

• New settings are NOT applied unless you press the OK or Enter key.

• To set the [Frame] setting as the default setting, press the Space key when the [Frame] dialog box 
appears.

 

Using Auto Format Layouts 2

Using Templates 2

Use templates to create labels by entering the text or selecting the format. Selectable Templates are listed 
in the Appendix, see Templates on page 224.

a Select [Templates] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select a category using the  or  key, and then press the OK or Enter key.
 

c Select a template using the  or  key, and then press the OK or Enter key.

d Enter text or a barcode for each text field if needed, and then press the OK or Enter key.

e When finished, press the OK or Enter key.
To print the label, select [Print] using the  or  key, and then press the OK or Enter key.

Note
• For more information about barcodes, see Creating a Barcode Label on page 27.

• You can use the serialize settings with the entered text and barcodes. To specify the serialize settings, 
see Entering a Serialized Label on page 21. (The Advanced Serialize mode cannot be used.)

• To print the label, see Printing a Label on page 42.

• To preview the label before printing, select [Preview] using the  or  key, and then press the OK or 
Enter key. For more information about the preview screen,  see Label Preview on page 46.

• To save the label, select [Save] using the  or  key, and then press the OK or Enter key.
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Using Block Layouts 2

Use pre-installed block layouts to create labels by just entering the text or barcodes. Selectable Block 
Layouts are listed in the Appendix, see Block Layouts on page 227.

a Select [Block Layouts] in the Home screen using the , ,  or  key, and then press the OK or 
Enter key.

b Select the tape width using the  or  key, and then press the OK or Enter key.

c Select a block layout using the  or  key, and then press the OK or Enter key.

d Enter text or a barcode for each text field if needed, and then press the OK or Enter key.

e When finished, press the OK or Enter key.
To print the label, select [Print] using the  or  key, and then press the OK or Enter key.

Note
• For more information about barcodes, see Creating a Barcode Label on page 27.

• You can use the serialize settings with the entered text and barcodes. To specify the serialize settings, 
see Entering a Serialized Label on page 21. (The Advanced Serialize mode cannot be used.)

• To print the label, see Printing a Label on page 42.

• To preview the label before printing, select [Preview] using the  or  key, and then press the OK or 
Enter key. For more information about the preview screen,  see Label Preview on page 46.

• To save the label, see Storing a Label in File Memory on page 49.
 

Cable Label Type 2

Create labels for cables, patch panels, and other equipment when performing electrical work by selecting the 
type of label and setting the necessary items.

a Select [Cable Label] in the Home screen using the , ,  or  key, and then press the OK or 
Enter key.

b Select a label type using the  or  key, and then press the OK or Enter key.

The available cable label types are as follows:

Note
Factory settings are shown in bold.
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Faceplate 2

Labels of this type can be used to identify various faceplates. Blocks of text are evenly spaced on each label.

 Label Length: 2.0" (50 mm), 0.4-39.0" (10-999 mm)

 # of Blocks: 1, 1-5

 Orientation:  (Horizontal),  (Vertical)

Cable Wrap 2

Labels of this type can be wrapped around a cable or wire. We recommend using Flexible ID Tape or 
Self-Laminating Tape for Cable Wrap labels.

 

 UOM (Unit of Measure): Dia(Ø), Length, CAT5/6, CAT6A, COAX, AWG, Rot.90

 Value: Varies depending on the UOM (Unit of Measure) setting

 Repeat: On, Off

 Cross-ID: Off, On

Note
When using Flexible ID Tape:

• We recommend using Flexible ID Tape for Cable Wrap labels.

• Labels made with Flexible ID Tape are not designed for use as electrical insulation.

• When wrapping labels around cylindrical objects, the diameter (1) of the object should be at least 0.12" 
(3 mm).

• The overlapping (2) ends of the label or the label flag should be at least 0.2" (5 mm).
 

 

One block Two blocks
  

Standard Rot.90
  

2

1
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Note
When using Self-Laminating Tape:

• The text is horizontally printed.

• When you insert the Self-Laminating Tape and select Cable Wrap, you can specify the following items.

 Label Length: Auto, 0.6-12" (15-300 mm)

 V. Offset (Adjusts Vertical Position): 0, -1, -2, -3, -4, -5, -6, -7, +7, +6, +5, +4, +3, +2, +1

 Cross-ID: Off, On
 

Cable Flag 2

Labels of this type can be wrapped around a cable or wire, and both ends of the label stick together to form 
a flag. The text on flag labels is printed on both ends of the label, leaving a blank space in the middle that 
wraps around the cable.
 

1 Flag length at least 0.6" (15 mm)

 Layout:  (same text on both sides),  (different text on each side)

 Flag Length: 1.2" (30 mm), 0.4-8.0" (10-200 mm)

 Cable Diameter: 0.24" (6 mm), 0.12-3.5" (3-90 mm)

 Orientation:  (Horizontal),  (Vertical)

 Cross-ID: Off, On

Note

• You can enter up to two barcodes when  is selected in flag layout.

• We recommend using Flexible ID Tape for Cable Flag labels.

• Labels made with Flexible ID Tape are not designed for use as electrical insulation.
 

Horizontal Vertical
 

1 Flag length

2 Cable circumference

 

1

1 2 1 1 2 1
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Patch Panel 2

Labels of this type can be used to identify various types of panels.
 

 Block Length: 0.60" (15.0 mm), 0.20-12.0" (5.0-300.0 mm)

 # of Blocks: 4, 1-99

 Separator:  (Tic),  (Dash),  (Line),  (Bold),  (Frame), 
 (None)

 Orientation:  (Horizontal),  (Vertical)

 Reverse: Off, On

 Advanced: Off, On

Adjust block length independently when Advanced setting is set to On.
 

1 Block length

 No Margins: Off, On 
Set the left and right label margins to zero.

Note
The Advanced and No Margins settings cannot be set to On at the same time.

 

1A-B01 1A-B02 1A-B03

1 1 1



Printing a Label Using the P-touch Labeling System Keyboard 

39

2

Punch-Down Block 2

Labels of this type can be used to identify a type of electrical connection, often used in telephony. You can 
enter up to eight lines for each block on a single label.
 

 

 Module Width: 8.0" (200 mm), 2.0-12.0" (50-300 mm)

 Block Type: 4 Pairs, 2 Pairs, 3 Pairs, 5 Pairs, Blank

 Sequence Type:  (None),  (Horizontal),  (Backbone)

 Start Value: ---, 1-99999

Note
• When Blank is selected in Block Type, Sequence Type is set to None.

• When None is selected in Sequence Type, --- appears for Start Value and you cannot set a value. 
Selecting Horizontal or Backbone however, allows you to set the Start Value setting from 1 to 99,999.

 

Die-cut Flag 2

Labels of this type can be printed on special die-cut flag labels to create flag labels for cables and wires.

Use FLe label cassettes for this type of application.
 

 Layout:  (same text in different directions on each side), 

 (same text in same direction on each side), 

 (different text in different directions on each side), 

 (different text in same direction on each side)

 Orientation:  (Horizontal),  (Vertical)
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Inverted Label 2

Labels of this type can be printed with the text and background colors reversed without changing the Tape 
Cassette. In addition, you can create labels with a small label height by setting [Orientation] to  
(Vertical).
 

 Label Length: Auto, 0.4-39.0" (5-999 mm)

 Orientation:  (Horizontal),  (Vertical)

Note
• The font and font style are set to Helsinki and bold respectively and cannot be changed.

• The following types of tape cannot be used:

• 0.13" (3.5 mm) tape

• Stencil tape

• Heat Shrink Tube

• Die-cut flag label
 

ON A
-0
1

A
-0
2

A
-0
3

A
-0
4

A
-0
5
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Setting Cross-ID 2

You can create/print Cross-ID labels when you select CABLE WRAP or CABLE FLAG.

a Select [Cable Label] in the Home Screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Cable Wrap] or [Cable Flag] using the  or  key.
 

c Select [Cross-ID] using the  or  key, and select [On] using the  or  key.
 

d 1 line: Enter the text and insert "/" or "\" where you want to apply Cross-ID.
2 or more lines: You can apply Cross-ID between lines by pressing the Enter key to create another line.

For example:
 

1 line 2 or more lines
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Printing a Label 2

Press the Esc key to exit or cancel most functions, or to return to the previous step in a series.

Feeding Tape 2

Important
• Be sure to feed tape to remove any slack in the tape and ink ribbon after inserting the Tape Cassette.

• Do not pull the label when the P-touch labeling system is ejecting it from the Tape Exit Slot. Doing 
so will cause the ink ribbon to be discharged with the tape. The tape may no longer be functional after the 
ink ribbon discharges.

• Do not block the Tape Exit Slot during printing or when feeding tape. Doing so will cause the tape to jam.
 

Feed and Cut 2

The Feed and Cut function feeds approximately 0.88" (22.3 mm) of blank tape, and then cuts the tape.

a Press the  (Feed and Cut) Button.
[Feed & Cut?] appears on the LCD.

b Select [Feed & Cut] using the  or  key, and then press the OK or Enter key. The message [Feeding 
Tape... Please Wait] appears while the tape is fed, and then the tape is cut.

Feed Only 2

This function ejects the tape approximately 0.88" (22.3 mm), resulting in a blank label sticking out of the Tape 
Cassette. This action is recommended when using Fabric tapes, which should be cut with scissors.

a Press the  (Feed and Cut) Button.
[Feed & Cut?] appears on the LCD.

b Select [Feed Only] using the  or  key, and then press the OK or Enter key. The message [Feeding 
Tape... Please Wait] appears while the tape is fed.
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Tape Cutting Options 2

The tape cutting options specify how the tape is fed and cut when printing labels.

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Cut Options] using the  or  key, and then press the OK or Enter key.

c Select the setting using the  or  key, and then press the OK or Enter key to apply the settings.

Note
New settings are NOT applied unless you press the OK or Enter key.

 

Tape Cutting Options

Cut Option No. Auto Cut Half Cut Chain Printing Image

1 No Yes No

 

2 Yes Yes No

 

3 No No No

 

4 Yes No No

 

5 No Yes Yes

 

ABCABC

ABC
ABC

ABCABC

ABC
ABC

ABCABC
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1 If you are using an FLe label cassette, set this cut option from a computer using the printer driver. These options cannot be set using the keyboard.

Note
• To reduce the blank space between printed labels when printing multiple copies of different labels, select 

Cut Option 5 through 8, which allow Chain Printing.

• When using a Chain Printing option, do not press the  (Feed and Cut) Button until the last label is 
printed.

 

6 Yes Yes Yes

 

7 No No Yes

 

8 Yes No Yes

 

9 Special tape

 

(FLe Label) 1 No ― ―

 

(FLe Label) 1 Yes ― ―

 

Tape Cutting Options

Cut Option No. Auto Cut Half Cut Chain Printing Image

ABC
ABC

ABCABC

ABC
ABC

ABC
ABC

ABCABC

ABC
ABC



Printing a Label Using the P-touch Labeling System Keyboard 

45

2

Label Adjustment 2

Adjusting the Label Length 2

When you reach the end of the installed Tape Cassette, label length may be affected.

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Adjust Length] using the  or  key, and then press the OK or Enter key.

c Set the value using the  or  key, and then press the OK or Enter key to apply the settings.

Note
Approximately 1% of the total label length will be adjusted by one level.

 

Setting Auto Fit Style 2

Use this function to reduce the text size to fit within a specific label length.

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Auto Fit Style] using the  or  key, and then press the OK or Enter key.

c Select the fit style using the  or  key.

Note
• Select [Text Size] is selected, the total text size is modified to fit all text within the label length.

• Select [Text Width] to reduce the text width to the size of the [x 1/2] setting. (If further size reduction 
is needed to fit the text into the selected label length, the total text size will be modified after reducing the 
text width to the [x 1/2] setting.)

 

d Press the OK or Enter key to apply the settings.

Note
To return to the default setting for [Text Size], press the Space key.
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Label Preview 2

a Press the Preview key.
An image of the label appears on the screen.
 

1 Indicates the position of the currently displayed portion of the label using the bar.

2 Indicates the information detected for the installed Tape Cassette. The first line indicates the 
character color and the second line indicates the tape color.

3 Press the Preview key to increase or decrease the magnification of the preview.

4 Indicates the tape width of the installed Tape Cassette and the label length as follows: 
Tape width x Label length.

Press the , ,  or  key to scroll the preview.
To scroll the preview to the left or right end, press the Shift key, and then press the  or  key.
Press the Preview key to change the magnification of the preview.

b Press Esc, OK, or Enter to exit Label Preview.

Note
• To print the label directly from the preview screen, press the Print key or open the [Print Options] 

screen and select a print option. (see Printing Labels on page 47).

• Print preview may differ slightly from the actual printed label.

• Installed Tape Cassette information (2) cannot be detected in some cassettes.
 

2

1

3
4
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Printing Labels 2

Be sure to check that there is enough tape remaining when printing several labels continuously. If tape is 
running low, set fewer copies, print labels one at a time, or replace the Tape Cassette.

Striped tape indicates the end of the Tape Cassette. If this appears during printing, press and hold the 

(Power) Button to turn off the P-touch labeling system. Attempting to print with an empty Tape Cassette 
may damage the P-touch labeling system.

To cancel the current print job, press the Cancel key.

Important
• Do not pull the label when the machine is ejecting it from the Tape Exit Slot.

• To prevent damage to the tape, do not touch any key while the [Printing... Copies] or [Feeding 
Tape... Please Wait] message appears.

• Do not block the Tape Exit Slot during printing or when feeding tape. Doing so will cause the tape to jam.
 

 

Printing a Single Page 2

Press the Print key, and then press the Print or OK key to start printing.

Printing Multiple Copies 2

Using this function you can print up to 99 copies of the same label.

a Press the Print key, and then select the number of copies using the  or  key, or type the number 
using the number keys.

b Press the Print or OK key to print.
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Printing a Range of Pages 2

When there are multiple pages, you can specify the range of pages to print.

a Press the Shift and Print keys.

b Select [Current Page] or [Range] using the  or  key, and then press the OK or Enter key. If you 
select [Current Page], go to step d.

c Using the , ,  or  key, specify the first page and the last page, and then select the number of 
copies.

Note
Blank pages are not printed.

 

d Press the Print or OK key to print.

Note
• If you need all pages, press the Print key, and then press the Print or OK key to print all pages without 

specifying the range.

• To cancel the current print job, press the Cancel key.

• The figures shown on the screen during printing indicate the “count/number of copies set”.

• Pressing the Space key when setting the number of copies resets the value to 01 (default).
 

Mirror Printing 2

Use clear tape so the labels can be read correctly from the opposite side when attached to glass, windows 
or other transparent surfaces.
 

a Press the Shift and Print keys.

b Select [Mirror-print current page] using the  or  key, and then press the OK or Enter key.

c Press the Print or OK key to print.
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Using File Memory 2

Store up to 99 of your most-frequently used labels the built-in file memory. When file memory is full, each time 
you save a file you will need to overwrite one of your stored files.

To check available space 1 in file memory: 
Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter key. 
Select [Memory Usage] using the  or  key, and then press the OK or Enter key. 
Select [Local Content] using the  or  key, and then press the OK or Enter key.
1 Because the file size may vary depending on the characters input and the type of data, you may not be able to store a file even if the available 

space that appears in [ Available : XXXXXchrs] indicates there is sufficient space.

Storing a Label in File Memory 2

a After typing and formatting the label, press the Save key.

b Select a file number using the  or  key, and then press the OK or Enter key.

Note
• If there is already a stored file for the number, the new label will overwrite the old one.

• To display the layout for the selected file number, press the Preview key.
 

c Type the file name, and then press the OK or Enter key.



Printing a Label Using the P-touch Labeling System Keyboard 

50

2

Opening/Printing a Label File Stored in File Memory 2

a On the Home screen, press the , ,  or  key to select [File], and then press the OK or Enter key.

b Select a file using the  or  key, and then press the OK or Enter key.

c Select [Open] using the  or  key, and then press the OK or Enter key. The file appears on the label 
creation screen.

d Press the Print key to print.

Deleting a Stored Label File 2

Important
To delete a label created using a transferred template, see Deleting the Transferred Data on page 63.

 

a On the Home screen, press the , ,  or  key to select [File], and then press the OK or Enter key.

b Select a file using the  or  key, and then press the OK or Enter key.

Note
To display the selected file, press the Preview key.

 

c Select [Delete] using the  or  key, and then press the OK or Enter key.
The [Delete?] message appears.

d Press the OK or Enter key to delete the file.
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Programming a Function 2

To save time, you can register up to 10 frequently-used functions that use built-in and/or downloadable 
symbols, images, label designs, and databases.

Press the PF (Programmable Function) key to recall registered function.

Note
For more information on Register Programmable Function, see FAQs & Troubleshooting on the Brother 
support website at support.brother.com.

 

Registering a New Function 2

a Select [Register Programmable Function] in the Home screen using the , ,  or  key, and 
then press the OK or Enter key. 

b Select [***] (not registered) using the  or  key, and then press the OK or Enter key. 

c Select the item category ([symbol], [transferred symbol], [database], [transferred 

template], or [file]) that you want to register using the  or  key, and then press the OK or Enter 
key.

d Select the item that you want to register, and then press the OK or Enter key.

e Enter the function name, and then press the OK or Enter key to register this function.
The function registration is completed.

Note
• The registered function name can be changed later.

• You can register up to 10 functions.  If 10 functions are already registered, you must delete one of the 
functions before registering a new function.

• If you recall a registered function and make changes to it, the revised function cannot be registered by 
overwriting the previous function. The revised function must be registered as a new function.  Delete any 
unnecessary functions.

 

Recalling and Using a Registered Function 2

a Press the PF (Programmable Function) key while the Home, label creation screens are displayed.

b Select a function using the  or  key, and then press the OK or Enter key.

Note
• You can also recall a function by typing the function number using the number keys.

• You can also recall a function by selecting [Register Programmable Function] in the Home screen.
 

https://support.brother.com/
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Deleting a Registered Function 2

a Select [Register Programmable Function] in the Home screen using the , ,  or  key, and 
then press the OK or Enter key.

b Select a function using the  or  key, and then press the OK or Enter key.

c Select [Delete] using the  or  key, and then press the OK or Enter key.
The [Delete?] message appears.

d Press the OK or Enter key.

Note
You can also recall a function by:

• typing the programmed number using the number keys.

• selecting [Register Programmable Function] in the Home screen.
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You can use a template, database, or symbol transferred from the computer to print the label.

Transferring Data from the Computer 3

Use the Transfer function of Cable Label Tool or P-touch Transfer Manager to transfer data from the 
computer to the P-touch labeling system.

For more information, see Transferring Templates from Cable Label Tool to the P-touch Labeling System 
on page 124 or How to Use P-touch Transfer Manager on page 129.

Transferred Symbols 3

To enter transferred symbols, see Entering Symbols on page 19.

Printing the Transferred Template 3

Transfer a label designed with P-touch Editor (*.lbx file) to the P-touch labeling system as a template for 
printing labels. You can enter data into the templates or print labels from a transferred database.

Important
• Before editing a template, transfer the template to the P-touch labeling system.

• When the transfer of the data to the P-touch labeling system is complete, turn off the P-touch labeling 
system, and then on again.

 

Press the Esc key to return to the previous step.

When the Template has No Object to be Edited 3

a Select [Transferred Templates] in the Home screen using the , ,  or  key, and then press 
the OK or Enter key.

Note
The names and numbers of the transferred templates and a preview of the selected template appears.

 

b Select the template using the  or  key, and then press the OK or Enter key.

Note

When the template is linked to a database, the  icon appears in the upper-right corner of the screen.
 

Using the Data Transferred to the P-touch 
Labeling System 3
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c Select [Print] or [Print from Database] using the  or  key to start printing.

Note
To select the range from the database that you want to print, follow steps c - e in When the Template is 
Linked to the Database and will not be Edited.

 

When the Template has an Object to be Edited 3

If needed, the template can be temporarily edited. However, the template cannot be saved after it is changed.

When the template is not linked to a database, to print the label you must first select the label template, and 
then type text in each of its fields.

When the template is linked to a database, you can print a single record or a range of records in the database 
linked to the template.

Important
You cannot add or delete line breaks.

 

a Select [Transferred Templates] in the Home screen using the , ,  or  key, and then press 
the OK or Enter key.

b Select the template using the  or  key, and then press the OK or Enter key.

Note

When the template is linked to a database, the  icon appears in the upper-right corner of the screen.
 

c Select [Edit Label without Saving] using the  or  key, and then press the OK or Enter key.
Objects that can be edited appear.

d Select the object to be edited using the  or  key, and then press the OK or Enter key.

When the template is not linked to a database:

The contents of the selected object appear. Edit the object, and then press the OK or Enter key.

When the template is linked to a database:

The first record of the database appears. Edit the object, and then press the OK or Enter key.

e When finished, press the Esc key.

f Select the menu using the  or  key to start printing.

When the template is not linked to a database:

Select [Print] using the  or  key to start printing.

When the template is linked to a database:

Select [Print from Database] or [Print Edited Label] using the  or  key to start printing.
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Note
• When editing templates linked to a database:

• When an object that is not linked to the database is edited, select [Print from Database] to print.

• When an object that is linked to the database is edited, the edited contents are deleted if you select 
[Print from Database]. Therefore, print the template just by selecting [Print Edited Label] 
using the  or  key.

• To select a print range from the database, follow steps c - e in When the Template is Linked to the 
Database and will not be Edited.

• To edit the database, see Editing the Database on page 60.
 

When the Template is Linked to the Database and will not be Edited 3

a Select [Transferred Templates] in the Home screen using the , ,  or  key, and then press 
the OK or Enter key.

b Select the template using the  or  key, and then press the OK or Enter key.

Note

When the template is linked to a database, the  icon appears in the upper-right corner of the screen.
 

c Select [Print from Database] using the  or  key, and then press the OK or Enter key.
The contents of the database linked to the template appear.

d Select the first record in the print range using the , ,  or  key, and then press the OK or Enter 
key.

e Select the last record in the print range using the , ,  or  key, and then press the OK or Enter 
key to start printing.
When the print range is set, the selected records are highlighted.
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Using Transferred Database Data 3

Transfer a database converted to a *.csv file to the P-touch labeling system.

Database data transferred without a template can be imported into each label except auto format layouts and 
transferred templates. The database data is imported according to the number of blocks and pages set for 
each label.

Important
• Before using a database, transfer the database to the P-touch labeling system.

• If a database and template are linked and transferred together, the database can use only that template.
 

Note
• If the selected database range is larger than the set number of blocks and pages, the data will be imported 

until the maximum number of blocks and pages is reached.

• If the set number of blocks and pages is larger than the selected database range, the operation will finish 
when the complete database is imported. The remaining blocks and pages will not be printed.

 

a Press the Insert key, select [Database] using the  or  key, and then press the OK or Enter key.

b Select the database using the  or  key, and then press the OK or Enter key.
The first record of the selected database appears.

Note
• If the selected record is not changed within a certain time while the database is displayed, the contents of 

the record will be displayed at the bottom of the screen. However, the contents of the record will not be 
displayed if the record contains 11 one-byte characters or fewer.

• When the Preview key is pressed, the properties of the record appear.

• When setting the range, the "field names" line (first line of data) cannot be selected.
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c Select the first record in the range that you want to insert, and then press the OK or Enter key.
The selected record is highlighted.
 

d Select the last record in the range that you want to insert, and then press the OK or Enter key.
The selected range is highlighted.
 

The contents of the selected database appear.
 



Using the Data Transferred to the P-touch Labeling System 

58

3

Searching the Database 3

While selecting a database record you want to use in a template or added to a label, search for records 
containing specific characters or a specific number.

The search proceeds to the right after the first matched string. Then, the database records will be searched 
in the same direction as the import order for the label type. The "field names" line is also searched.

The database search characters include upper-case and lower-case letters (including accented characters), 
numbers, and the upper symbols shown on the keys.

a Press the Insert key, select [Database] using the  or  key, and then press the OK or Enter key.

b Select the database you want using the  or  key, and then press the OK or Enter key.
The first record of the selected database appears.
 

c Type in the first character (for example, "B") that you want to search for.
Example: If you type "B", the fields are searched from the first field for character strings containing "B".
 

If a string that contains "B" is found, the cursor moves to that data and "B" is highlighted. In addition, "B" 
is stored in the internal memory.
If a string that contains the searched character "B" is not found, the cursor remains in its current position 
without moving and the character "B" is not stored in the internal memory.
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d Type in the second character (for example, "R") that you want to search for.
Next, if you type "R", the fields will be searched from the next field for character strings containing "BR".
 

If a string that contains "BR" is found, the cursor moves to that data and "BR" is highlighted. In addition, 
"BR" will be stored in the internal memory.

e Continue searching the database using the same procedure.

Note
• If the character that you searched for is contained in multiple fields in the database, press the Next key to 

move to the next field containing the character. The character is highlighted in the field.
 

• Press the BS (Backspace) key to delete the last search character. The cursor will move to the field 
containing the remaining search characters.
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Editing the Database 3

a Press the Insert key, select [Database] using the  or  key, and then press the OK or Enter key.

b Select the database to edit using the  or  key, and then press the OK or Enter key.

Note
You can also select the database you want to edit using the following procedure: 
Select [Transferred Templates] in the Home screen using the , ,  or  key, and then press 
the OK or Enter key. Select the template linked to a database to edit using the  or  key, and then press 
the OK or Enter key. Select [Print from Database] using the  or  key, and then press the OK or 
Enter key.

 

The first record of the selected database appears.
 

c Select the cell using the , ,  or  key, and then press and hold the OK or Enter key.
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d Enter the new text.
 

Important
• You can add or delete a line break.

• Each cell can contain a maximum of 17 lines.
 

e Press OK key and the new text appears.
 

Note
If you do not want to print the database, press the OK key, and then press the Esc key. The edited data 
will be saved.

 

f Press the OK key again.
The edited record becomes highlighted.
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g Do one of the following:

When the database has been transferred with a template:

Select the last record in the print range using the , ,  or  key, and then press the OK or Enter 
key to start printing.

When the print range is set, the selected records are highlighted.
 

When the database has been transferred without a template:

Select the last record in the range that you want to insert, and then press the OK or Enter key.

The selected range is highlighted. The contents of the selected database appears.
 

 

h Press the Print key.
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Deleting the Transferred Data 3

Use the following methods to delete transferred data.

Multiple items cannot be deleted together. Delete each item separately.

Deleting Transferred Symbols 3

a Press the Insert key, select [Transferred Symbols] using the  or  key, and then press the OK or 
Enter key.

b Select the transferred symbol you want to delete using the  or  key, and then press the Clear key.
The [Delete?] message appears.

c Press the OK or Enter key.
The selected transferred symbol is deleted and the next image is selected.
If needed, delete the next image.

Deleting Templates 3

a Select [Transferred Templates] in the Home screen using the , ,  or  key, and then press 
the OK or Enter key.

b Select the template you want to delete using the  or  key, and then press the OK or Enter key.

c Select [Delete] using  or  key, and then press the OK or Enter key.
The [Delete?] message appears.

d Press the OK or Enter key.
The selected template is deleted and the next template is selected.
If needed, delete the next template.

Deleting Databases 3

a Press the Insert key.

b Select the database you want to delete using the  or  key, and then press the Clear key.
The [Delete?] message appears.

c Press the OK or Enter key.
The selected database is deleted and the next database is selected.
If needed, delete the next database.
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Installing the Printer Driver and Software 4

To print from your Windows computer or Mac, install the printer driver, Cable Label Tool, P-touch Editor and 
other applications.

Important
Do not connect the P-touch labeling system to the computer until asked to do so.

 

a Visit our website (install.brother) and download the installer for the software and manuals.

b Double-click the downloaded file and follow the on-screen instructions to proceed with the installation.

Note
• After the installation starts, select which items to install.

• To connect the P-touch labeling system to a computer using a wireless connection, we recommend the 
following:

• Configure the wireless network settings while installing the software. You can change the settings later 
using the [Settings] in the Home screen or Printer Setting Tool. For more information, see 
Connecting Using Wi-Fi on page 65 or Changing System Settings on page 83.

• Install the software on a computer wirelessly connected to your network and configuring the P-touch 
labeling system using a USB Cable.

• Get the SSID (network name) and password (network key) of the wireless network in advance.
 

c Close the dialog box when the installation is complete.

Connecting the P-touch Labeling System to a Computer 4

Press the Esc key to return to the previous step.

Refer to the directions for the type or connection method:

 USB Cable connection

See Connecting Using USB on page 64.

Wireless LAN connection

See Connecting Using Wi-Fi on page 65.

Connecting Using USB 4

a Before connecting the USB Cable, make sure that the P-touch labeling system is turned off.

b Connect the P-touch labeling system end of the USB Cable to the USB Port on the back of the P-touch 
labeling system.

Printing Using a Computer 4

http://install.brother
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c Connect the other end of the USB Cable to the USB Port on the computer.

d Turn on the P-touch labeling system.

Connecting Using Wi-Fi 4

Select the network type, configure or display the network settings using [Settings] in the Home screen. You 
can also use Communication settings in the Printer Setting Tool for detailed configuration. For more 
information see Changing System Settings on page 83.

The following Wi-Fi connection methods are available:

 Infrastructure Mode

 Ad-Hoc Mode (To set the Ad-Hoc mode, use the Printer Setting Tool (for more information, see Changing 
System Settings on page 83).)

Infrastructure Mode 4

Infrastructure mode allows you to connect the P-touch labeling system to a computer via a wireless access 
point/router.

 Before You Begin

First, you must configure the Wi-Fi settings of your P-touch labeling system to communicate with your 
wireless access point/router. After the P-touch labeling system has been configured, computers on your 
network will have access to the P-touch labeling system.

Important
• If you are going to connect the P-touch labeling system to your network, we recommend contacting your 

system administrator prior to installation. You must confirm your Wi-Fi settings before you proceed with 
this installation.

• To configure the Wi-Fi settings again, or if the status of the Wi-Fi connection for your P-touch labeling 
system is not clear, reset the Wi-Fi settings of the P-touch labeling system.

1 Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key. 

2 Select [Reset] using the  or  key, and then press the OK or Enter key.

3 Select [Reset Wi-Fi Settings] using the  or  key, and then press the OK or Enter key.
 

Note
• We recommend preparing the SSID (network name) and password (network key) of the wireless network 

in advance.

• To achieve the best results with everyday document printing, use the P-touch labeling system as close to 
the wireless access point/router as possible with minimal obstructions. Large objects and walls between 
the two devices and interference from other electronic devices can affect the data transfer speed of your 
documents.
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 Configuring using the Setup Wizard

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [WLAN] using the  or  key, and then press the OK or Enter key.

c Select [Infrastructure Mode] using the  or  key, and then press the OK or Enter key.

d Select [Network Setting] using the  or  key, and then press the OK or Enter key.

e Select [Setup Wizard] using the  or  key, and then press the OK or Enter key.

f If any messages appear, press the OK or Enter key for each message.
The SSIDs for the available networks appear.
 

g Select the SSID using the  or  key, or select [Other...] and enter the SSID (from 1 to 32 
characters), and then press the OK or Enter key.
The [Password] screen appears.
 

h Enter the password (from 8 to 63 characters or, when using WEP, from 5 to 13 characters), and then 
press the OK or Enter key.

i The screen returns to the [Settings] menu screen, and  (Wi-Fi) indicator blinks while the 
connection is being established.
After 90 seconds, the indicator will change to , but your P-touch labeling system will continue trying 
to connect to the network.

j When connected, depending on the strength of the wireless signal, the wireless connection indicator 

shows one of the following symbols: 



Printing Using a Computer 

67

4

Note
If you start the setup wizard for the Infrastructure mode or select the network settings for the Direct mode 
when the wireless function of the P-touch labeling system is turned off, [Turning on Wi-Fi Radio] 
appears and the wireless function turns on automatically (or after the OK key is pressed). It is no longer 
necessary to turn the Infrastructure mode or Direct mode on manually.
 

 Connecting the P-touch labeling system to your wireless access point/router using a computer

a First, write down the SSID (network name) and password (network key) of your wireless access 
point/router.

b Connect the P-touch labeling system and computer with a USB Cable.

c Press and hold the  (Wi-Fi) Button on your P-touch labeling system  for one second to turn the Wi-Fi 
function on. The  (Wi-Fi) indicator starts flashing in green once every three seconds.

d Configure the Infrastructure Mode settings of the P-touch labeling system using the computer.

 For Windows

Start the Printer Setting Tool on your computer, and click Communication settings. Select 
Infrastructure or Ad-hoc or Infrastructure and Wireless Direct for Selected Interface in 
Communication settings in the General tab, and select Infrastructure for Communication 
Mode in Wireless Settings in the Wireless LAN tab.

For details, see Changing System Settings on page 83.

 For Mac

Start the Wireless Device Setup Wizard included in the Printer Driver Package, and then follow the 
on-screen instructions. The Wireless Device Setup Wizard can be found in the Utilities folder.

e Enter the SSID that you wrote down, or click Search and select the SSID from the displayed list.

f Enter the password in the Passphrase field.

Note
The required information depends on the authentication method and encryption mode; enter only the 
information relevant to your network environment.

 

g To send the settings to the P-touch labeling system, click Apply.
When the connection between the P-touch labeling system and your wireless access point/router is 
established, the  (Wi-Fi) indicator turns green. Computers on the same network as the P-touch 
labeling system will have access to the P-touch labeling system.

Note
To change any other network settings, use the Printer Setting Tool (for more information, see Changing 
System Settings on page 83).
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WPS (Wi-Fi Protected Setup™)

If your wireless access point/router supports WPS, you can configure settings and connections wirelessly.

a First, confirm that your wireless access point/router has the WPS symbol.
 

b Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

c Select [WLAN] using the  or  key, and then press the OK or Enter key.

d Select [Infrastructure Mode] using the  or  key, and then press the OK or Enter key.

e Select [Network Setting] using the  or  key, and then press the OK or Enter key.

f Place your P-touch labeling system within the range of your wireless access point/router. The range 
may differ depending on your environment. See the instructions provided with your wireless access 
point/router.

g Select [Button Push] using the  or  key, and then press the OK or Enter key.

h Press the OK or Enter key for a message that appears before the [Start WPS on Your Wireless 
Access Point].
The [Start WPS on Your Wireless Access Point] message appears.

i Press the WPS button on your wireless access point/router, and then press the OK or Enter key on 
your P-touch labeling system.

j [Connecting...] appears for a while, and then [Connected!] appears.

k Press the OK or Enter key.
The screen returns to the [Settings] menu screen.
Depending on the strength of the wireless signal, the wireless connection indicator may show one of 
the following symbols: 

Note
• If you start the setup wizard for the Infrastructure mode or select the network settings for the Direct mode 

when the wireless function of the P-touch labeling system is turned off, [Turning on Wi-Fi Radio] 
appears and the wireless function turns on automatically (or after the OK key is pressed). It is no longer 
necessary to turn the Infrastructure mode or Direct mode on manually.

• Your P-touch labeling system will try to connect using WPS for two minutes. If the (Wi-Fi) Button is 
pressed and held during that time, the P-touch labeling system will continue trying to connect for an 
additional two minutes.
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• If your P-touch labeling system could not connect to the network, a message indicating that the connection 
failed appears.
 

 Configuring by entering the PIN

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [WLAN] using the  or  key, and then press the OK or Enter key.

c Select [Infrastructure Mode] using the  or  key, and then press the OK or Enter key.

d Select [Network Setting] using the  or  key, and then press the OK or Enter key.

e Select [PIN Code] using the  or  key, and then press the OK or Enter key.

f If some messages appear, press the OK or Enter key for each message.

g Type the PIN displayed on the screen into your wireless access point/router, and then press the OK 
or Enter key.
 

h Connecting... appears for a while, and then Connected! appears.

i Press the OK or Enter key.
The screen returns to the Settings menu screen.
Depending on the strength of the wireless signal, the wireless connection indicator may show one of 
the following symbols: 

Note
If you start the setup wizard for the Infrastructure mode or select the network settings for the Direct mode 
when the wireless function of the P-touch labeling system is turned off, Turning on Wi-Fi Radio 
appears and the wireless function turns on automatically (or after the OK key is pressed). It is no longer 
necessary to turn the Infrastructure mode or Direct mode on manually.
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Ad-Hoc Mode 4

For Windows, after installing the printer driver and other applications to your computer, set the Ad-Hoc mode 
using the Printer Setting Tool installed on the computer.

For Mac, set the Ad-Hoc mode using the Wireless Device Setup Wizard.

Turning the Wireless Function On or Off 4

To turn the wireless function on or off, press the (Wi-Fi) Button.

a Press the (Wi-Fi) Button. The wireless function is now on. The (Wi-Fi) indicator lights/flashes in 
green.

b Press the (Wi-Fi) Button again to turn the wireless function off. The (Wi-Fi) indicator turns off.

Note
• If [Off] is selected in the [Direct Mode On/Off] and [Infrastructure Mode On/Off] screen, the 

wireless function will remain off even if you press the (Wi-Fi) Button. (The factory setting is "On" for both 
Direct mode and Infrastructure mode.) For more information see Infrastructure Mode on page 65 or 
Connecting the P-touch labeling system to a Mobile Device on page 76.

• When the wireless function is on, the rechargeable Li-ion battery power will decrease quickly. To change 
the power source, connect the AC Adapter.
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Printing from a Computer 4

Available Applications 4

To use the P-touch labeling system effectively, a number of applications and functions are available.

You must install the printer driver to use these applications.

Visit our website (install.brother) and download the installer for the applications and printer driver.

Application Windows Mac Features

Cable Label Tool r
Create and print labels for cables, patch panels, faceplates, 
electrical equipment and more.

P-touch Editor r r
Design and print custom labels with built in drawing tools, 
text using different fonts and styles, imported graphic images 
and barcodes.

P-touch Transfer Manager r

It allows you to transfer templates and other data to the 
P-touch labeling system  and save backups of your data on 
the computer.

This application is installed with P-touch Editor.

P-touch Library r

Manage and print P-touch Editor templates.

You can use P-touch Library to print templates.

This application is installed with P-touch Editor.

P-touch Update Software r r Update software to the latest version.

Printer Setting Tool r r Specify the printer's device settings from a computer.

Wireless Device Setup 
Wizard

r
This application allows you to configure your printer for a 
wireless network.

BRAdmin Light r
Finds the P-touch labeling system on your network and is 
used to make basic configuration settings from your 
computer.

BRAdmin Professional r
Finds the P-touch labeling system on your network and is 
used to make advanced configuration settings and updates 
from your computer.

http://install.brother


Printing Using a Computer 

72

4

Printing from Your Computer 4

There are various ways to print using this P-touch labeling system.

Follow these steps to print from a computer using Cable Label Tool or P-touch Editor.

a Start the Cable Label Tool or P-touch Editor, and then open the document you want to print.

b Create a label design.

c Check the cutting options (for more information, see Cutting Options on page 73).

d Select File > Print or by click the Print icon.

Useful Function Windows Mac Features

Distributed printing r

When printing a large number of labels, printing can be 
distributed among multiple printers.

Because printing is performed at the same time, the total 
printing time can be reduced.

For more information, see Printing Labels Distributed to 
Multiple Printers (Windows only) on page 106.

High resolution printing r

Print in higher resolution.

For more information, see Printing Labels in High Resolution 
Mode on page 109.

High speed printing r

Print faster.

For more information, see Printing Labels in High Speed 
Mode on page 110.
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Cutting Options 4

The cutting options allow you to specify how the item is fed and cut when it is printed. Use the printer driver 
to select the cutting option when printing from the computer using the application.

The following table lists the Cutting Option settings:

Tape Cut Option Table

Auto Cut Half Cut Chain Printing Image

No Yes No

 

Yes Yes No

 

No No No

 

Yes No No

 

No Yes Yes

 

Yes Yes Yes

 

ABCABC

ABC
ABC

ABCABC

ABC
ABC

ABCABC

ABC
ABC
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Note
• When printing multiple copies of different labels, select chain printing option to reduce the blank space 

between the labels (for more information, see the Tape Cut Option Table).

• When using the chain printing option, press the  (Feed and Cut) Button after the last label is printed.
 

No No Yes

 

Yes No Yes

 

Special tape

 

No 
(FLe Label)

― ―

 

Yes 
(FLe Label)

― ―

 

Tape Cut Option Table

Auto Cut Half Cut Chain Printing Image
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ABC

ABC
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Attaching Labels 4

a If needed, trim the printed label to the shape and length you want with scissors.

b Peel the backing from the label.

c Position the label, and then press firmly from top to bottom with your finger to attach the label.

Note
• The backing of some types of tapes may be pre-cut to make it easier to peel the backing. To remove the 

backing, simply fold the label lengthwise with the text facing inwards, to expose the inside edges of the 
backing. Next, peel off the backing one piece at a time.

• Labels may be difficult to attach to surfaces that are wet, dirty, or uneven. The labels may peel off easily 
from these surfaces.

• Extra Strength Adhesive Tape:

• For rough and textured surfaces, we recommend using Extra Strength Adhesive Tape.

• Be sure to read the instructions provided with Fabric Tapes, Extra Strength Adhesive Tapes or other 
special tapes and observe all precautions noted in the instructions.
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Installing Applications for Use with Mobile Devices 5

Brother offers various applications for use with your P-touch labeling system, including applications that allow 
you to print directly from your Apple iPhone, iPad, and iPod touch or Android™ smartphone or tablets, and 
applications that allow you to transfer data, such as templates, symbols, and databases created using a 
computer, to your P-touch labeling system wirelessly.

Connecting the P-touch labeling system to a Mobile Device 5

You can connect your P-touch labeling system to a mobile device. To create and print labels directly from 
your mobile device, install the Brother mobile applications, and then connect your P-touch labeling system to 
your mobile device.

 Connecting using the P-touch labeling system keyboard

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [WLAN] using the  or  key, and then press the OK or Enter key.

c Select [Direct Mode] using the  or  key, and then press the OK or Enter key.

The P-touch labeling system displays the  symbol.

d Select [Network Setting] using the  or  key, and then press the OK or Enter key.

Printing Using a Mobile Device 5

For more information about the mobile applications available for your printer, visit 
support.brother.com/g/d/f5f9.

https://support.brother.com/g/d/f5f9
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Note
• If you start the setup wizard for the Infrastructure mode or select the network settings for the Direct mode 

when the wireless function of the P-touch labeling system is turned off, [Turning on Wi-Fi Radio] 
appears and the wireless function turns itself on automatically (or after the OK key is pressed). It is no 
longer necessary to turn the Infrastructure mode or Direct mode on manually.

• When the wireless function is on, the rechargeable Li-ion battery power will decrease quickly. To change 
the power source, connect the AC Adapter.

 

e The current SSID appears on-screen. Enter the new SSID if needed, and then press the OK or Enter 
key.

f The current password appears on-screen. Enter the new password if needed, and then press the OK 
or Enter key.

g The screen to confirm the entered SSID and password appears. Press any key to continue, and then 
go to the wireless network settings page of your mobile device and type the SSID name and 
password.

h You have completed the Wireless Direct network setup.

 Connecting using a Computer

a Confirm the Wireless Direct settings of the P-touch labeling system.

 For Windows

Connect the P-touch labeling system and computer with a USB Cable. Start the Printer Setting 
Tool on your computer, and click Communication settings. Confirm that Infrastructure and 
Wireless Direct or Wireless Direct is selected for Selected Interface in Communication 
settings in the General tab.

For more information, see Printer Setting Tool for Windows on page 83.

 For Mac

Connect the P-touch labeling system and computer with a USB Cable. Start the Printer Setting 
Tool on your computer, and confirm that WirelessDirect is set to On in the Wireless LAN tab.

For more information, see Printer Setting Tool for Mac on page 100.

b Press and hold the  (Wi-Fi) Button on your P-touch labeling system for one second to turn the Wi-Fi 
function on. 
The  (Wi-Fi) indicator starts flashing in green once every three seconds.

c In the Wi-Fi settings screen of your mobile device, select the SSID of the P-touch labeling system and 
enter the password.
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Note
• The factory settings for the SSID and password are as follows:

SSID: “PT-D800W” or “DIRECT-*****_PT-D800W” where “*****” is the last five digits of the product serial 
number.

(You can find the serial number label on the bottom of the P-touch labeling system.)

Password (network key): 00000000

• You can connect the P-touch labeling system to a mobile device in the Infrastructure Mode via a wireless 
access point/router.

• You cannot connect to the Internet via Wi-Fi with computer while using Wireless Direct. To use the 
Internet, connect using Infrastructure mode.

 

Turning the Wireless Function On or Off 5

To turn the wireless function on or off, press the (Wi-Fi) Button.

a Press the (Wi-Fi) Button. The wireless function is now on. The (Wi-Fi) indicator lights/flashes in 
green.

b Press the (Wi-Fi) Button again to turn the wireless function off. The (Wi-Fi) indicator turns off.

Note
• If [Off] is selected in the [Direct Mode On/Off] and [Infrastructure Mode On/Off] screen, the 

wireless function will remain off even if you press the (Wi-Fi) Button. (The factory setting is "On" for both 
Direct mode and Infrastructure mode.) For more information see Connecting the P-touch labeling system 
to a Mobile Device on page 76 or Infrastructure Mode on page 65.

• When the wireless function is on, the rechargeable Li-ion battery power will decrease quickly. To change 
the power source, connect the AC Adapter.
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Printing from a Mobile Device 5

Printing from Your Mobile Device 5

a Start the application (Mobile Cable Label Tool/Brother iPrint&Label) on your mobile device.

Note
Make sure that the P-touch labeling system is connected to your mobile device.

For more information, see Connecting the P-touch labeling system to a Mobile Device on page 76.
 

b Select a label template or design.

Note
You can also select a previously deigned label or image, and print it.

 

c Check the cutting option (for more information, see Cutting Options on page 79).

d Tap Print in the application menu.

Cutting Options 5

The cutting options allow you to specify how the item is fed and cut when it is printed. Use the printing option 
to select the cutting option when printing from the mobile device using the application.

See the following table for a list of all available settings:

Tape Cut Option Table

Auto Cut Half Cut Chain Printing Image

No Yes No

 

Yes Yes No

 

No No No
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Yes No No

 

No Yes Yes

 

Yes Yes Yes

 

No No Yes

 

Yes No Yes

 

Special tape

 

No 
(FLe Label) 

(Mobile Cable Label 
Tool only)

― ―

 

Tape Cut Option Table

Auto Cut Half Cut Chain Printing Image
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Note

• When printing multiple copies of different labels, select chain printing option to reduce the blank space 
between the labels (for more information, see the Tape Cut Option Table).

• When using the chain printing option, press the  (Feed and Cut) Button after the last label is printed.
 

Using a Mobile Device to Print Templates Created on a Computer 5

You can use P-touch Transfer Manager to save template data, which was created using P-touch Editor, in 
the BLF format. Then, you can use Mobile Transfer Express to send the saved file from your mobile device 
to the P-touch labeling system and print the file.

a Save the template data in the BLF format using P-touch Transfer Manager.
For more information, see Creating a BLF File on page 139.

b Use one of the following methods to use a .blf file with your mobile device.

 Save the file using a cloud storage service, and then use the sharing function of the mobile device's 
OS to share the file.

 Send the file as an email attachment from the computer to the mobile device, and then save the file 
to the mobile device.

c Connect the P-touch labeling system to your mobile device, and then start Mobile Transfer Express.
The template data appears.

d Select the template that you want to print, and then transfer the template to the P-touch labeling system.

Note
To download a file from a cloud storage service to your mobile device, you must connect your mobile 
device using Infrastructure Mode. Therefore, if you also connect your mobile device to the P-touch labeling 
system using Infrastructure Mode, you can quickly transfer downloaded files.

 

e Use the Keyboard LCD Unit of the P-touch labeling system to select the template that you want to print 
from the transferred file and print it.

Yes 
(FLe Label) 

(Mobile Cable Label 
Tool only)

― ―

 

Tape Cut Option Table

Auto Cut Half Cut Chain Printing Image
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Attaching Labels 5

a If needed, trim the printed label to the shape and length you want with scissors.

b Peel the backing from the label.

c Position the label, and then press firmly from top to bottom with your finger to attach the label.

Note
• The backing of some types of tapes may be pre-cut to make it easier to peel the backing. To remove the 

backing, simply fold the label lengthwise with the text facing inwards, to expose the inside edges of the 
backing. Next, peel off the backing one piece at a time.

• Labels may be difficult to attach to surfaces that are wet, dirty, or uneven. The labels may peel off easily 
from these surfaces.

• Extra Strength Adhesive Tape:

• For rough and textured surfaces, we recommend using Extra Strength Adhesive Tape.

• Be sure to read the instructions provided with Fabric Tapes, Extra Strength Adhesive Tapes or other 
special tapes and observe all precautions noted in the instructions.
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Printer Setting Tool for Windows 6

Using the “Printer Setting Tool”, specify the printer's communication settings or device settings from a 
computer.

Note
The “Printer Setting Tool” is installed automatically when you use the initial installer to install the printer 
driver. For more information, see Installing the Printer Driver and Software on page 64.

 

Important
The “Printer Setting Tool” is available only with compatible Brother printers.

 

Before Using the Printer Setting Tool 6

 Make sure the AC Adapter is connected to the P-touch labeling system and to an AC Power Outlet, or a 
fully-charged battery is installed.

 Make sure the printer driver has been installed correctly and you can print.

 Connect this P-touch labeling system to a computer with a USB Cable. Settings cannot be specified using 
Wi-Fi using this tool.

Changing System Settings 6
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Using the Printer Setting Tool for Windows 6

a Connect the P-touch labeling system you want to configure to the computer.

b Start the Printer Setting Tool.

 For Windows 7: 

Click  (Start) > All Programs > Brother > Label & Mobile Printer > Printer Setting Tool.

 For Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2: 
Click the Printer Setting Tool icon on the Apps screen.

 For Windows 10: 

Click  (Start) > All apps > Brother > Label & Mobile Printer > Printer Setting Tool.

The main window appears.
 

1 Printer
Lists the connected printers.

2 Communication settings
Specifies wireless LAN communication settings.

3 Device Settings
Specifies printer device settings, such as power settings and printer settings.

4 Exit
Closes the window.

3

2

4

1
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c Check that the P-touch labeling system you want to configure appears next to Printer. If a different 
printer appears, select the P-touch labeling system you want from the drop-down list.

Note
If only one P-touch labeling system is connected, it is unnecessary to make a selection because only that 
P-touch labeling system is available.

 

d Select the setting you want to change, and then specify or change the settings in the dialog box.
For more information on the settings dialog boxes, see Communication Settings for Windows on page 86 
or Device Settings for Windows on page 95.

e Click Apply > Exit in the settings dialog box to apply the settings to the P-touch labeling system.

f Click Exit in the main window to finish specifying settings.

Important
Use the “Printer Setting Tool” to configure the P-touch labeling system only when the P-touch labeling 
system is in standby. The P-touch labeling system may malfunction if you try to configure it while it is 
handling a job.
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Communication Settings for Windows 6

With Communication settings in the “Printer Setting Tool”, the printer communication information can be 
specified or changed when connecting the printer and computer with a USB Cable. Not only can you change 
the communication settings for one printer, but you can also apply the same settings to multiple printers.

Settings Dialog Box 6

 

1 Disable these settings

When this check box is selected,  appears in the tab, and the settings can no longer be specified or 

changed.

Settings in a tab where  appears will not be applied to the printer even if Apply is clicked. In addition, 

the settings in the tab will not be saved or exported when the Save in Command File or Export command 
is executed.
To apply the settings to the printer or save or export them, make sure you clear the check box.

2 Items
When Current Status is selected, the current settings appear in the settings display/change area.
Select the item for the settings that you want to change.

3 Menu Bar

4 Printer
Lists the connected printers.

5 Node Name
Displays node name (nodes can be renamed).

7
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6 Settings Tabs
Contains settings that may be specified or changed.

If  appears in the tab, the settings in that tab will not be applied to the printer.

7 Settings Display/Change Area
Displays the current settings for the selected item.

8 Refresh
Updates the displayed settings with the most recent information.

9 Exit
Exits Communication settings, and returns to the main window of the “Printer Setting Tool”.

Important
Settings are not applied to printers if Exit is clicked without clicking Apply after changing settings.
 

10 Apply
Applies the settings to the printer.
To save the specified settings in a command file, select Save in Command File from the drop-down list.
The saved command file can be used with the mass storage mode to apply the settings to a printer (for 
more information, see Mass Storage Mode on page 112).

Important
Clicking Apply applies all settings in all tabs to the printer.
If the Disable these settings check box is selected, the settings in that tab are not applied.
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Menu Bar 6

 

1 Apply Settings to the Printer
Applies the settings to the printer.

2 Save Settings in Command File
Saves the specified settings in a command file. The file extension is .bin.
The saved command file can be used with the mass storage mode to apply the settings to a printer (for 
more information, see Mass Storage Mode on page 112).

Note
If the Disable these settings check box is selected, the settings in that tab are not saved.
 

Important
• The following information is not saved with the command file:

• Node name
• IP address, subnet mask and default gateway (when the IP address is set to STATIC)

• The saved communication settings commands are intended to be used only for applying settings to a 
printer. To apply the settings to the printer using this command file, use the mass storage mode.

• Saved command files contain authentication keys and passwords. Take necessary measures to protect 
saved command files, such as saving them in a location that cannot be accessed by other users.

• Do not send the command file to a different printer model.
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3 Import
 Import from the current computer wireless settings

Imports the settings from the computer.

Note
• When importing the computer wireless settings, administrator privileges for the computer are needed.
• Only personal security authentication settings (open system, public key authentication and 

WPA/WPA2-PSK) can be imported. Enterprise security authentication (such as LEAP and EAP-FAST), 
WPA2-PSK (TKIP) and WPA-PSK (AES) settings cannot be imported.

• If multiple wireless LANs are enabled for the computer you use, the first wireless settings (only personal 
settings) that are detected will be considered for the import data.

• Only the settings (communication mode, SSID, authentication method, encryption mode and 
authentication key) from the Wireless LAN tab > Wireless Settings pane can be imported.

 

 Select a Profile to import
Imports the exported file and applies the settings to a printer.
Click Browse and select the file you want to import. The settings in the selected file appear in the 
settings display/change area.

Note
• All settings, such as wireless settings or TCP/IP settings, can be imported, except for node names.
• Only profiles that are compatible with the selected printer can be imported.
• If the imported profile’s IP address is set to STATIC, change the IP address of the imported profile, if 

needed, so that it does not duplicate the IP address of an existing configured printer on the network.
 

4 Export
Saves the current settings in a file. 

Note
If the Disable these settings check box is selected, the settings in that tab are not saved.
 

Important
Exported files are not encrypted.
 

5 Automatically restart the printer after applying new settings
If this check box is selected, the printer automatically restarts after communication settings are applied.
If this check box is cleared, your must restart the printer manually.

Note
When configuring multiple printers, you can reduce the time needed to change settings by clearing this 
check box. In this case, we recommend selecting this check box when configuring the first printer so that 
you can confirm that each setting is operating as intended.
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6 Automatically detects the connected printer, and retrieves the current settings.
If this check box is selected and a printer is connected to the computer, the printer is automatically 
detected and the printer's current settings are displayed in the Current Status pane.

Note
If the model of the connected printer is different from that of the printer shown in the Printer drop-down 
list, the settings available on all tabs change to match the connected printer.
 

7 Change Node Name/Bluetooth Device Name
Allows renaming a node.

8 Reset to Default Communication Settings
Returns the communication settings to their factory settings.

9 Display Help
Displays the Help.

10 About
Displays the version information.

General Tab 6

Communication Settings 6

 Network Settings on Power On

Specifies the conditions for connecting via Wi-Fi when the printer is turned on. Select On by Default, Off 
by Default or Keep Current State.

 Selected Interface

Select Infrastructure or Ad-hoc, Infrastructure and Wireless Direct or Wireless Direct.

IPv6 6

 IPv6 usage

Select Enable or Disable.

 Priority on IPv6 address

Select to give priority to an IPv6 address.
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Wireless LAN Tab 6

TCP/IP (Wireless) 6

 Boot Method

Select AUTO, BOOTP, DHCP, RARP or STATIC.

 IP Address/Subnet Mask/Gateway

Specifies the various networking values.

You can enter these settings only when the IP address is set to STATIC.

 DNS Server Method

Select AUTO or STATIC.

 Primary DNS Server IP Address/Secondary DNS Server IP Address

You can enter these settings only when the DNS server is set to STATIC.

IPv6 6

 Static IPv6 Address

Specifies a permanent IPv6 address.

 Enable this address

Enables the specified static IPv6 address.

 Primary DNS Server IPv6 Address/Secondary DNS Server IPv6 Address

Specifies the DNS server IPv6 addresses.

 IPv6 Address List

Displays the list of IPv6 addresses.

Wireless Settings 6

 Communication Mode

Select Infrastructure or Ad-hoc.

 SSID (Network Name)

Clicking Search displays the available SSID selections in a separate dialog box.

 Channel

Lists available channels.

Note
This setting is valid only in Ad-Hoc mode.
Not all computers, mobile devices, and operating systems, may support Ad-hoc mode.
 

 Authentication Method/Encryption Mode 

The supported encryption modes for the authentication methods are as shown in Communication Modes 
and Authentication Methods/Encryption Modes on page 92. 
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WEP Key

You can specify a setting only when WEP is selected as the encryption mode. 

 Passphrase

You can specify a setting only when WPA/WPA2-PSK is selected as the authentication method.

 User ID/Password 

You can specify settings only when LEAP, EAP-FAST, PEAP, EAP-TTLS or EAP-TLS is selected as the 
authentication method. In addition, with EAP-TLS, it is not necessary to register a password, but a client 
certificate must be registered. To register a certificate, connect to the printer from a web browser, and then 
specify the certificate. For more information on using a web browser, see Web Based Management 
on page 170.

 Display the key and password on-screen

If this check box is selected, keys and passwords are displayed in plain (non-encrypted) text.

Communication Modes and Authentication Methods/Encryption Modes 6

When Communication Mode is set to Ad-hoc

When Communication Mode is set to Infrastructure

Important
To specify higher level security settings:
When performing certificate verification with EAP-FAST, PEAP, EAP-TTLS or EAP-TLS authentication 
methods, the certificate cannot be specified from the "Printer Setting Tool". After the printer is configured 
to connect to the network, specify the certificate by accessing the printer from a web browser.

For more information on using a web browser, see Web Based Management on page 170.
 

Authentication Method Encryption Mode

Open System None / WEP

Authentication Method Encryption Mode

Open System None / WEP

Shared Key WEP

WPA/WPA2-PSK TKIP+AES / AES

LEAP CKIP

EAP-FAST/NONE TKIP+AES / AES

EAP-FAST/MS-CHAPv2 TKIP+AES / AES

EAP-FAST/GTC TKIP+AES / AES

PEAP/MS-CHAPv2 TKIP+AES / AES

PEAP/GTC TKIP+AES / AES

EAP-TTLS/CHAP TKIP+AES / AES

EAP-TTLS/MS-CHAP TKIP+AES / AES

EAP-TTLS/MS-CHAPv2 TKIP+AES / AES

EAP-TTLS/PAP TKIP+AES / AES

EAP-TLS TKIP+AES / AES
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Wireless Direct Tab 6

Wireless Direct Settings 6

 SSID (Network Name)/Network Key

Specifies the SSID (25 ASCII characters or fewer) and the network key (63 characters or fewer) you want 
to use in the Wireless Direct mode.

Note
The factory settings for the SSID and password are as follows:

SSID: “PT-D800W” or “DIRECT-*****_PT-D800W”. "*****" is the last five digits of the product serial 
number.

Password (Network key): 00000000
 

Applying Setting Changes to Multiple Printers 6

a After applying settings to the first printer, disconnect the printer from the computer, and then connect the 
second printer to the computer.

b Select the newly connected printer from the Printer drop-down list.

Note
If the Automatically detects the connected printer, and retrieves the current settings. check box in 
the Option Settings dialog box is selected, the printer connected with the USB Cable is automatically 
selected.

For more information, see Communication Settings for Windows on page 86.
 

c Click Apply.
The same settings that were applied to the first printer are applied to the second printer.

Note
We recommend selecting the Automatically restart the printer after applying new settings check box 
when configuring the first printer so that you can confirm that a connection with the wireless access 
point/router can be correctly established with the settings. For more information, see Communication 
Settings for Windows on page 86.

 

d Repeat steps a – c for all printers whose settings you want to change.

Important
If the IP address is set to STATIC, the printer's IP address will also be changed to the same address as 
the first printer. 
Change the IP address if needed.
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Note
To save the current settings in a file, click File > Export.

The same settings can be applied to another printer by clicking File > Import, then selecting the exported 
settings file (for more information, see Communication Settings for Windows on page 86).
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Device Settings for Windows 6

With Device Settings in the “Printer Setting Tool”, printer settings can be specified or changed when 
connecting the printer and computer with a USB Cable. Not only can you change the device settings for one 
printer, but you can also apply the same settings to multiple printers.

When printing from a computer application, various printing settings can be specified from the printer driver; 
however, by  using Device Settings in the “Printer Setting Tool”, more advanced settings can be specified.

When Device Settings is opened, the printer's current settings are retrieved and displayed. If the current 
settings could not be retrieved, the previous settings are displayed. If the current settings could not be 
retrieved and previous settings have not been specified, this tool’s factory settings are displayed.

Settings Dialog Box 6

 

1 Menu Bar
Select a command contained in each menu from the list.

2 Printer
Specifies the printer whose device settings are to be configured.
If only one printer is connected, it is unnecessary to make a selection since only that printer will appear.

3 Settings Tabs
Contains settings that may be specified or changed.

Note

If  appears in the tab, the settings in that tab cannot be specified or changed. In addition, the settings 

in the tab will not be applied to the printer even if Apply is clicked. The settings in the tab will also not be 
saved or exported when the Save in Command File or Export command is executed.
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4 Current Settings
Retrieves the settings from the currently connected printer and displays them in the dialog box. Settings 

will also be retrieved for parameters on tabs with .

5 Disable these settings

When this check box is selected,  appears in the tab, and the settings can no longer be specified or 

changed.

Settings in a tab where  appears will not be applied to the printer even if Apply is clicked. In addition, 

the settings in the tab will not be saved or exported when the Save in Command File or Export command 
is executed.

6 Parameters
Displays the current settings.

7 Exit
Exits Device Settings, and returns to the main window of the “Printer Setting Tool”.

8 Apply
Applies the settings to the printer.
To save the specified settings in a command file, select Save in Command File from the drop-down list.
The saved command file can be used with the mass storage mode to apply the settings to a printer (for 
more information, see Mass Storage Mode on page 112).
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Menu Bar 6

 

1 Apply Settings to the Printer
Applies the settings to the printer.
Performs the same operation as when Apply is clicked.

2 Save Settings in Command File
Saves the specified settings in a command file.
Performs the same operation as when Save in Command File is selected from the Apply drop-down list.

3 Import
Imports the exported file.

4 Export
Saves the current settings in a file.

5 Save Print Log in File
Saves the print log in a file in the CSV format.

6 Print Unit Settings
Prints a report containing firmware version and device setting information.

You can also print this report using the (Feed and Cut) Button for more than 10 seconds. See 
Confirming System Settings on page 105 for more information.

Note
When you print this report, use 0.94" (24 mm) or 1.4" (36 mm) tape.
 

7 Factory Reset
Resets all printer settings to factory settings.
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8 Delete Template and Database
Deletes the templates and databases stored in the printer.

9 Delete Print Log
Deletes the print log stored in the printer.

10 Option Settings
If the Do not display an error message if the current settings cannot be retrieved at startup check 
box is selected, a message will not be displayed next time.

11 About
Displays the version information.

Basic Tab 6

 Auto Power On

Specifies whether or not the printer turns on automatically when the Power Supply Cord is plugged into an 
AC Power Outlet.

Available settings: Disable, Enable

 Auto Power Off (AC/DC)

Specifies the period of time that passes before the printer turns off automatically when connected to an 
AC Power Outlet.

Available settings: None, 10/20/30/40/50 Minutes, 1/2/4/8/12 hours

 Auto Power Off (Li-ion)

Specifies the amount of time that passes before the printer turns off automatically when powered by the 
rechargeable Li-ion battery.

Available settings: None, 10/20/30/40/50 Minutes, 1 hour

 Contents

Specifies the printer information that will be printed.

Available settings: All, Usage Log, Printer Settings, Printer Transfer Data

 Save Printer Print Log

Select whether or not to save the printer's print log. If Disable is applied to the printer, Maintenance > 
Save Print Log in File does not work.

Available settings: Enable, Disable
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Label Settings Tab 6

 Length Adjustment

Adjusts the length of the printed label to correspond to the length of the label displayed on the computer.

Available settings: -4 to +4 (1 increments)

 Full Cut Margin Adjustment

Adjusts the margin length when fully cutting labels.

Available settings: -2 to +2 (1 increments)

 Half Cut Margin Adjustment

Adjusts the margin length when half-cutting labels.

Available settings: -2 to +2 (1 increments)

 Test Print

Prints a test label to check the results of each adjustment.

Applying Setting Changes to Multiple Printers 6

a After applying settings to the first printer, disconnect the printer from the computer, and then connect the 
second printer to the computer.

b Select the newly connected printer from the Printer drop-down list.

c Click Apply.
The same settings that were applied to the first printer are applied to the second printer.

d Repeat steps a – c for all printers whose settings you want to change.

Note
To save the current settings in a file, click File > Export.

The same settings can be applied to another printer by clicking File > Import, and then selecting the 
exported settings file (for more information, see Device Settings for Windows on page 95).
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Printer Setting Tool for Mac 6

Using the “Printer Setting Tool”, specify the printer’s communication settings and device settings from a 
Mac. Not only can you change the device settings for one printer, but you can also apply the same settings 
to multiple printers.

Note
The “Printer Setting Tool” is installed automatically when you use the initial installer to install the printer 
driver. For more information, see Installing the Printer Driver and Software on page 64.

 

Important
The “Printer Setting Tool” is available only with compatible Brother printers.

 

Before Using the Printer Setting Tool 6

 Make sure the AC Adapter is connected to the P-touch labeling system and to an AC Power Outlet, or a 
fully-charged battery is installed.

 Make sure the printer driver has been installed correctly and you can print.

 Connect this P-touch labeling system to a computer with a USB Cable. Settings can be specified only via 
USB using this tool.

Using the Printer Setting Tool for Mac 6

a Connect the P-touch labeling system you want to configure to the computer.

b Click Macintosh HD > Applications > Brother > Printer Setting Tool > Printer Setting Tool.app.
The Printer Setting Tool window appears.

c Check that the P-touch labeling system you want to configure appears next to Printer. If a different 
printer appears, select the P-touch labeling system you want from the drop-down list.

Note
If only one P-touch labeling system is connected, it is unnecessary to make a selection because only that 
P-touch labeling system will appear.

 

d Select a setting tab, and then specify or change the settings.

e Click Apply Settings to the Printer in the setting tab to apply the settings to the P-touch labeling 
system.

f Click Exit to finish specifying settings.

Important
Use the Printer Setting Tool to configure the P-touch labeling system only when the P-touch labeling 
system is in standby. The P-touch labeling system may malfunction if you try to configure it while it is 
handling a job.
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Settings Dialog Box 6

 

1 Printer
Lists the connected printers.

2 Import
Imports settings from a file.

3 Export
Saves the current settings in a file.

4 Setting Tabs
Contain settings that may be specified or changed.

5 Apply Settings to the Printer
Applies the settings to the printer.

6 Print Unit Settings
Prints a report containing firmware version and configuration information.
You can also print this report using the (Feed and Cut) Button for more than 10 seconds. See 
Confirming System Settings on page 105 for more information.

Note
When you print this report, use 0.94" (24 mm) or 1.4" (36 mm) tape.
 

7 Factory Reset
Resets printer settings to factory settings.

8 Current Settings
Retrieves the settings from the currently connected printer and displays them in the dialog box.

9 Exit
Exits the Printer Setting Tool.
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Basic Tab 6

 Auto Power On

Specifies whether the printer turns on automatically when the Power Supply Cord is plugged into an AC 
Power Outlet.

Available settings: Disable, Enable

 Auto Power Off (AC/DC)

Specifies the period of time that passes before the printer turns off automatically when connected to an 
AC Power Outlet.

Available settings: None, 10/20/30/40/50 Minutes, 1/2/4/8/12 hours

 Auto Power Off (Li-ion)

Specifies the period of time that passes before the printer turns off automatically when powered by the 
rechargeable Li-ion battery.

Available settings: None, 10/20/30/40/50 Minutes, 1 hour

 Print Information Report

Specifies the printer information that will be printed.

Available settings: All, Usage Log, Printer Settings, Printer Transfer Data

 Save Printer Print Log

Select whether or not to save the printer’s print log.

Available settings: Enable, Disable

Label Settings Tab 6

 Length Adjustment

Adjusts the length of the printed label to correspond to the length of the label displayed on the computer.

Available settings: -4 to +4 (1 increments)

 Full Cut Margin Adjustment

Adjusts the margin length when fully cutting labels.

Available settings: -2 to +2 (1 increments)

 Half Cut Margin Adjustment

Adjusts the margin length when half-cutting labels.

Available settings: -2 to +2 (1 increments)

 Test print

Prints a test label to check the results of each adjustment.
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Wireless LAN Tab 6

WirelessDirect

Turns the Wireless Direct function on or off.

 SSID/Network Key Generation

Select AUTO or STATIC.

 SSID (Network Name)/Network Key

Specifies the SSID (3 to 25 ASCII characters) and the network key you want to use in the Wireless Direct 
mode.

You can specify a setting only when STATIC is selected as SSID/Network Key Generation.

 Display current settings

Displays the current settings for Wireless Direct. Click Current Settings to update the displayed settings 
with the most recent information.

Applying Setting Changes to Multiple Printers 6

a After applying settings to the first printer, disconnect the printer from the computer, and then connect the 
second printer to the computer.

b Select the newly connected printer from the Printer drop-down list.

c Click Apply Settings to the Printer.
The same settings that were applied to the first printer are applied to the second printer.

d Repeat steps a – c for all printers whose settings you want to change.

Note
To save the current settings in a file, click Export.

The same settings can be applied to another printer by clicking Import, then selecting the exported 
settings file (for more information, see Settings Dialog Box on page 101).
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Changing Settings When Printing from a Mobile Device 6

If using a mobile device, change the settings as necessary using the application before printing.

The settings that can be changed vary according to the application.

Note
Before connecting a mobile device, you can specify detailed settings by connecting the P-touch labeling 
system to a computer via USB and using the Printer Setting Tool (for more information, see Using the 
Printer Setting Tool for Windows on page 84).
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Confirming System Settings 7

You can print a system settings report or display the system setting information without connecting the 
P-touch labeling system to a computer or mobile device.

To print the basic settings report:

Note
This report contains the following information: The firmware version, device setting information, Wi-Fi 
setting information, and transferred data information (templates, databases and transferred symbols).

 

a Turn on the P-touch labeling system.

b Press and hold the  (Feed and Cut) Button for more than 10 seconds to print the report.

Note
• When you print this report, use 0.94" (24 mm) or 1.4" (36 mm) tape.

• This operation can also be performed using the Printer Setting Tool (for more information, see Changing 
System Settings on page 83).

 

Other Functions 7
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Printing Labels Distributed to Multiple Printers (Windows 
only) 7

Distributed Printing 7

When printing a large number of labels, printing can be distributed among multiple printers. Because printing 
is performed at the same time, the total printing time can be reduced. You cannot use this function for 
Self-Laminating Tape.

Note
• Printing can be distributed to printers connected via a USB or network connection.

• The number of pages is automatically divided among the selected printers. If the specified number of 
pages cannot be evenly divided among the printers, it will be divided in the order of the printers listed in 
the dialog box when the print settings are specified in step d.

 

 

a From the File menu in P-touch Editor, click Print.

b Click Properties….

67 67 66

200
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c Click the Advanced tab, select the Distributed Printing check box, and then click Settings.
 

d In the Distributed Printing Settings dialog box, select the printers you want to use for distributed 
printing.
 

1 Click Detect Current Paper Information….

2 The current printer information that was detected appears below Current Width and Paper Type.

3 Select the check box next to the Printer Name you want.

Note

If the selected tape width is different from that displayed beside Current Width,  appears beside the 
setting below Current Width. Load the printer with tape of the width specified Set Width.

 

3
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e Specify the tape width.

A. If only one printer has been selected.

In the Distributed Printing Settings dialog box from step d, select the printer whose setting you want 
to specify, and then either double-click it, or right-click it and then click Settings. From the Set Width 
drop-down list, select the tape width.

Note
Information displayed in the Distributed Printing Settings dialog box from step d can be entered in the 
Notes text box.

 

B. If multiple printers have been selected.

In the Distributed Printing Settings dialog box from step d, select the printers whose settings you 
want to specify, right-click them, and then click Settings. From the Set Width drop-down list, select the 
tape width. The same tape width setting is applied to all selected printers.

Note
The settings below Printer Settings and Notes are not available.

 

f Click OK to close the tape width setting window.

g Click OK to close the Distributed Printing Settings window.
Setup is completed.

h Click OK to start distributed printing.

Note
• It may not be possible for information to be detected for a printer connected using a USB hub or print 

server. Before printing, enter the settings manually, and check if the printer can be used for printing.

• Depending on whether a router is used and the security features in use, such as a firewall, it may not be 
possible to use this function.

• We recommend performing a connection test for your operating environment. Contact your information 
technology manager or administrator for assistance.
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Printing Labels in High Resolution Mode 7

High resolution printing can be used if you are printing from a computer, the AC Adapter is connected, and 
TZe and HGe laminated tape with black ink is installed. Use the printer driver to select the high resolution 
mode when printing the labels. You cannot use this function for TZe-FX**1 tape.

a From the File menu in P-touch Editor, click Print.

b Click Properties….

c On the Basic tab, select High resolution from the Quality drop-down list.
 

d Click OK.
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Printing Labels in High Speed Mode 7

High speed printing can be used if you are printing from a computer, the AC Adapter is connected, and TZe 
and HGe laminated tape with black ink is installed. Use the printer driver to select the high speed mode when 
printing the labels. You cannot use this function for TZe-FX**1 tape.

a From the File menu in P-touch Editor, click Print.

b Click Properties….

c On the Basic tab, select High Speed from the Quality drop-down list.
 

d Click OK.
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Printing Labels in High Quality Mode 7

High quality printing can be used if you are printing from a computer, and TZe laminated tape with black ink 
is installed. Use the printer driver to select the high quality mode when printing the labels. You cannot use 
this function for TZe-FX**1 tape.

a From the File menu in P-touch Editor, click Print.

b Click Properties….

c On the Basic tab, select High Quality from the Quality drop-down list.
 

d Click OK.

Note
• You can select the high quality mode in P-touch Editor. Click File > Print, and then select the Priority to 

print quality check box under Options.

• You can also select the high quality mode using the keybord LCD unit.
Select Settings in the Home screen using the , ,  or key, and then press the OK or Enter key.
Select High Quality using the  or  key, and then press the OK or Enter key.
Select High Quality using the  or  key, and then press the OK or Enter key to apply the settings.
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Mass Storage Mode 7

Description 7

The mass storage mode feature allows you to communicate with the P-touch labeling system with just a file 
via the USB interface without loading a printer driver. Files that have been copied to the P-touch labeling 
system's mass storage area are processed when you press the Print key.

This feature is useful for:

 Applying printer settings saved in a command file (.bin file format) or adding templates (.blf file format) into 
the P-touch labeling system distributed by the administrator without using any software tools.

 Executing commands without installing the printer driver.

 Using a device with an OS (including non-Windows operating systems) that has a USB host feature to print 
and transmit data.

Using the Mass Storage Mode 7

a Confirm that the P-touch labeling system is turned off.

b Press and hold the (Power) Button, the PF (Programmable Function) key, and the Home key at the 
same time.

The P-touch labeling system starts up in mass storage mode, the (Power) indicator lights in green and 
the (Label) Indicator lights in orange.

c Connect the computer or device to the P-touch labeling system via USB.
The P-touch labeling system's mass storage area appears as a folder on the computer or device's 
screen.

Note
If the mass storage area does not appear automatically, refer to the operating instructions for the computer 
or device’s operating system for information about displaying the mass storage area.

 

d Drag and drop the file you want to copy to the mass storage area.

e Press the Print key.
The commands in the command file are executed, and the (Label) Indicator flashes once in green.
When finished, the (Label) Indicator lights in orange.

f To turn mass storage mode off, turn off the P-touch labeling system so that it starts in its normal 
operating mode.
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Important
• When the P-touch labeling system is turned off, mass storage mode is deactivated and any files in the 

mass storage area are deleted.

• This feature supports .bin, and .blf files. Other file formats are not supported.

• Do not create folders in the mass storage area. If a folder is created, files in the folder cannot be accessed.

• The capacity of the mass storage area is 2.5 MB. Files larger than 2 MB may not work correctly.

• If multiple files are copied, the order that the commands will be executed in cannot be guaranteed.

• Wi-Fi features are not available while the P-touch labeling system is running in mass storage mode.

• Do not access other files in the mass storage area when executing a copied file.
 

Note
For more information on how to create a .blf file, see Creating a BLF File on page 139.
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Installing P-touch Software 8

You must install P-touch software and the printer driver to use your P-touch labeling system with your 
computer.

Download the installer from install.brother.

For more information on installing the software and driver, see Installing the Printer Driver and Software 
on page 64.

To download the latest driver and software individually, visit the Brother support website at 
support.brother.com.

Select your region/country. > Downloads > Choose your product

Using P-touch Software 8

http://install.brother
https://support.brother.com/
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Starting Cable Label Tool 9

a Start the Cable Label Tool.

 For Windows 7:

Click  (Start) > All Programs > Brother P-touch > Cable Label Tool 1.0.

 For Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2:

Click Cable Label Tool 1.0 on the Apps screen.

 For Windows 10:

Click  (Start) > All apps > Brother P-touch > Cable Label Tool 1.0.

b Click the cable label you want.
 

How to Use Cable Label Tool 9
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Cable Label Types 9

Faceplate 9

Labels of this type can be used to identify various faceplates.

Blocks of text are evenly spaced on each label.
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Cable Wrap 9

Labels of this type can be wrapped around a cable or wire.

The text is rotated 90° counterclockwise and printed.
 

Note
When using Flexible ID Tape:

• We recommend using Flexible ID Tape for the "Cable Wrap" labels.

• Labels made with Flexible ID Tape are not designed for use as electrical insulation.

• When wrapping labels around cylindrical objects, the diameter (1) of the object should be at least 0.12" 
(3 mm).

• The overlapping (2) ends of the label should be at least 0.2" (5 mm).
 

 

2

1
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Cable Flag 9

Labels of this type can be wrapped around a cable or wire, and both ends of the label stick together to form 
a flag.

The text on flag labels is printed on both ends of the label, leaving a blank space in the middle that wraps 
around the cable.
 

Note
• The flag length (1) should be at least 0.6" (15 mm).

 

• Orientation

• We recommend using Flexible ID Tape for the "Cable Flag" labels.

• Labels made with Flexible ID Tape are not designed for use as electrical insulation.
 

Horizontal Vertical
  

1 Flag length
2 Cable circumference

1

1 2 1 1 2 1
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Patch Panel 9

Labels of this type can be used to identify various types of panels.
 

Punch-Down Block 9

Labels of this type can be used to identify a type of electrical connection, often used in telecommunications. 
You can enter up to eight lines for each block on a single label.
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Die-cut Flag 9

Labels of this type can be printed on special die-cut flag labels to create flag labels for cables and wires.

Use FLe label cassettes for this type of application.
 

Heat Shrink Tube 9

Tubes of this type can be heated to shrink-fit cables. 

Use HSe tube cassettes for this type of application.
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Linking a Database to a Template 9

To print labels using data in a database, link the database. You don't have to input data to the labels manually.

a Click Database.

b Select a database.

c The database linked to the template appears.
Specify the data to print and the number of copies.
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Serialized Number Printing 9

To print labels in sequential order, use the Serialize function.

a Highlight the text you want to serialize.
 

b Click Serialize.
 

c Specify the settings using the screen image as an example.

Printing with Cable Label Tool 9

You can print by selecting Print from the File menu or by clicking the Print button. (Configure the printing 
settings in the Print screen before printing.)
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Transferring Templates from Cable Label Tool to the P-touch 
Labeling System 9

Using the transfer function, you can transfer a template or a template with a database to the P-touch labeling 
system without using P-touch Transfer Manager.

a Display the template to transfer in the layout window.

b Click Transfer.
The Transfer Template dialog box appears.
 

c Select the assignment key.

Note
Each data is assigned a key number (memory location in the P-touch labeling system).

If the template or other data transferred to the printer has the same key number as another template 
already saved in the printer, the new template will overwrite the old one.

 

d  To transfer a template with a connected database, select the Transfer with Database check box.

e Click Transfer.
The template or template with database is transferred to the printer.

Note
• Serialize settings will not be transferred.

• When transferring a template with a database, if the linked database has multiple sheets, only the sheet 
currently displayed in the database dialog box is transferred.
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Starting P-touch Editor 10

a Start the P-touch Editor.

 For Windows 7:

Click  (Start) > All Programs > Brother P-touch > P-touch Editor.

 For Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2:

Click P-touch Editor on the Apps screen.

 For Windows 10:

Click  (Start) > All apps > Brother P-touch > P-touch Editor.

b When P-touch Editor starts, select whether you want to create a new layout or open an existing layout.

Note
To change how P-touch Editor functions when it starts, click Tools > Options in the P-touch Editor menu 
bar to display the Options dialog box. On the left side, select the General heading, and then the setting 
you want in the Operations list box under Startup Settings. The factory setting is Display New View.

 

c Select one of the displayed options:
 

1 To create a new layout, double-click New Layout, or click New Layout and then click .

2 To create a new layout using a preset layout, double-click a category button, or select a category 
button and then click .

3 To connect a preset layout to a database, select the check box next to Connect Database.

4 To open an existing layout, click Open.

How to Use P-touch Editor 10

2

1
5

4 3
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5 To open the application for creating labels for electrical equipment management, double-click Cable 
Labelling Wizard, or click Cable Labelling Wizard and then click .

 



How to Use P-touch Editor 

127

10

Printing with P-touch Editor 10

Express Mode 10

This mode allows you to quickly create layouts that include text and images.
 

You can print by selecting Print from File in the menu bar or by clicking the Print icon. (Configure the printing 
settings in the Print screen before printing.)

Professional Mode 10

This mode allows you to create layouts using a wide-range of advanced tools and options.
 

You can print by selecting Print from File in the menu bar or by clicking the Print Setting icon (A). Configure 
the printing settings in the Print screen before printing.

In addition, click the Print icon “B” to start printing without changing the printing settings.

B

A
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Snap Mode 10

This mode allows you to capture all or a portion of your computer screen display, print it as an image, and 
save it for future use.

a Click the Snap mode selection button.
The Description of Snap mode dialog box appears.
 

b Click OK.
The Snap mode palette appears.
 

Transferring Data to the P-touch Labeling System 10

To transfer data to the P-touch labeling system, you must use P-touch Transfer Manager. For more 
information, see How to Use P-touch Transfer Manager on page 129.
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P-touch Transfer Manager allows you to transfer templates and other data to the P-touch labeling system and 
save backups of your data on a computer.

Transferring Templates to P-touch Transfer Manager 11

To use P-touch Transfer Manager, you must first transfer any templates created in P-touch Editor to P-touch 
Transfer Manager.

a In P-touch Editor, open the template to be transferred.

b Click the File menu, and then click Transfer Template > Transfer.

Note
The following method can also be used to start P-touch Transfer Manager:

• For Windows 7: 

Click  (Start) > All Programs > Brother P-touch > P-touch Tools > P-touch Transfer Manager.

• For Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2: 
On the Apps screen, click P-touch Transfer Manager.

• For Windows 10:

Click  (Start) > All apps > P-touch Transfer Manager under Brother P-touch.
 

How to Use P-touch Transfer Manager 11
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1 Menu bar
Provides access to various commands, which are grouped under each menu title (File, Edit, View, Tool, 
and Help) according to their functions.

2 Toolbar
Provides access to frequently used commands.

3 Printer selector
Allows you to select which P-touch labeling system to transfer the data. When you select a P-touch 
labeling system, only the data that can be sent to the selected P-touch labeling system appears in the data 
list.

4 Folder view
Displays a list of folders and printers. When you select a folder, the templates in the selected folder appear 
in the template list.
If you select a P-touch labeling system, the current templates and other data stored in the P-touch labeling 
system appear.

5 Template list
Displays a list of templates in the selected folder.

6 Preview
Displays a preview of the templates in the templates list.

2

4

1

3

5

6
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Toolbar Icons

Icon Button name Function

 

Transfer

(for P-touch Transfer Manager  
only)

Transfers templates and other data from the computer to the 
P-touch labeling system.

Save Transfer File

(when not connected to a 
P-touch labeling system)

Changes the file type of the data to be transferred to other 
applications.

Select "BLF" for the filename extension when printing the label 
using Mass Storage Mode (USB), or when transferring the data 
using BRAdmin Professional (Wi-Fi) or Mobile Transfer Express 
(Wi-Fi).  Select "PDZ" when transferring the data using 
TransferExpress (USB).

The available interfaces differ depending on your model.
 Backup

(for P-touch Transfer Manager 
only)

Retrieves the templates and other data saved in the P-touch 
labeling system and saves it on the computer.

 

Open Opens the selected template.

 

Print

(for P-touch Library only)
Prints the selected template from the P-touch labeling system.

 

Search
Allows you to search for templates or other data registered to the 
P-touch Library.

 

Display Style Changes the file display style.
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Transferring Templates or Other Data from the Computer to 
the P-touch Labeling System 11

Use the following procedure to transfer templates, databases, and images from your computer to the P-touch 
labeling system.

a Connect the computer and the P-touch labeling system via USB and turn on the P-touch labeling system.
The P-touch labeling system model name appears next to a printer icon in the folder view.
If you select the P-touch labeling system in the folder view, the current templates and other data stored 
in the P-touch labeling system appear.

Note
• If your P-touch labeling system is disconnected or offline, it does not appear in the folder view.

• Before transferring data, check that the computer and the P-touch labeling system are correctly connected 
using a USB Cable or a wireless connection, and that the P-touch labeling system is on.

 

b Select the P-touch labeling system to which you want to transfer templates or other data.
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c Right-click the Configurations folder, select New, and then create a new folder.
 

d Click and drag the template or other file that you want to transfer to the new folder. You can drag multiple 
files at once into a single folder.

Transfer Function Specification

Data type
Maximum number of 

transferable items
Restriction details

Template 99
 Each template can contain a maximum of 50 objects.

 Each object can contain a maximum of 17 lines.

Database 99

 Only *.csv files can be transferred.

 Each *.csv file can contain a maximum of 256 fields and 
65000 records.

Image 
(transferred symbols)

99

 Only *.bmp files can be transferred.

 Monochrome *.bmp files are recommended.

 The size limit is 2048 × 2048 pixels.

 Wide images may be cropped.
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Note

To confirm the available space 1 on the P-touch labeling system:

a. Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b. Select [Memory Usage] using the  or  key, and then press the OK or Enter key.

c. Select [Transferred Content] using the  or  key, and then press the OK or Enter key.
1 Because the file size may vary depending on the characters input and the type of data, you may not be able to store a file even if the available 

space that appears in [Available : X.XXMB indicates] there is sufficient space.
 

View the templates and other data by selecting one of the following:

 The new folder you just created in the Configurations folder

 The All Contentsfolder

 One of the categories in the Filter folder, based on the data you just transferred, for example, 
Layouts.

Each file is assigned a key number when it is placed in the new folder.
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e To change the key number assigned to an item, right-click the item, click the Key Assign drop-down 
arrow, and then select the key number you want.
 

Note
• Except for the data in databases, all data transferred to the P-touch labeling system is assigned a key 

number.

• If the template or other data transferred to the P-touch labeling system has the same key number as 
another template already saved in the P-touch labeling system, the new file will overwrite the old one. 
Confirm the key number assignments saved in the P-touch labeling system by backing up the templates 
or other data before transferring new files (for more information, see Backing up Templates or Other Data 
Saved in the P-touch Labeling System on page 137).

• If the P-touch labeling system memory is full, remove one or more files from the P-touch labeling system 
memory (for more information, see Backing up Templates or Other Data Saved in the P-touch Labeling 
System on page 137).

 

f To change the names of templates or other data that you want to transfer, click the item you want, and 
then type the new name. The number of characters used for the template names may be limited, 
depending on your model.
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g Select the folder containing the templates or other data that you want to transfer, and then click Transfer 
in the menu bar. A confirmation message appears.
 

Note
• You can transfer individual files to the P-touch labeling system without adding them to a folder: 

Select the template or other data that you want to transfer, and then click Transfer in the menu bar.

• Multiple files can be selected and transferred at once.
 

h Click OK.
 

Note
To print data that was transferred to the P-touch labeling system, you must turn off the P-touch labeling 
system and then turn it on again.
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Backing up Templates or Other Data Saved in the P-touch 
Labeling System 11

Use the following procedure to retrieve templates or other data saved in the P-touch labeling system and save 
it on your computer.

Important
• Backed-up templates or other data cannot be edited on the computer.

• Depending on your model, templates or other data backed up from one P-touch labeling system model 
may not be able to be transferred to another P-touch labeling system model.

 

a Connect the computer and the P-touch labeling system and turn on the P-touch labeling system.
The P-touch labeling system model name appears next to a printer icon in the folder view.
If you select the P-touch labeling system in the folder view, the current templates and other data stored 
in the P-touch labeling system appear.

b Select the P-touch labeling system that contains the files you want to back up, and then click Backup in 
the menu bar. 
 

c When the confirmation window appears, click OK.
A new folder is created under the P-touch labeling system in the folder view. The folder name is based 
on the date and time of the backup. All of the P-touch labeling system's templates and other data are 
transferred to the new folder and saved on the computer.
 



How to Use P-touch Transfer Manager 

138

11

Deleting All Templates and Other Data on the P-touch 
Labeling System 11

a Connect the computer and the P-touch labeling system and turn on the P-touch labeling system.
The P-touch labeling system model name appears next to a printer icon in the folder view.

b Right-click the P-touch labeling system and select Delete All from the menu.
 

c When the confirmation window appears, click OK.
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Creating a BLF File 11

Use P-touch Transfer Manager to save template data, created using P-touch Editor, in BLF format. You can 
transfer these files in this format to a printer over a network, from a computer or mobile device, and print files 
in BLF format when your P-touch labeling system is in Mass Storage mode.

a Create a template using P-touch Editor, and then transfer it to P-touch Transfer Manager (for more 
information, see Transferring Templates to P-touch Transfer Manager on page 129).

b Without connecting the P-touch labeling system to the computer, select Configurations in the P-touch 
Transfer Manager window, and then select the template you want to save.

Note
You can select multiple templates at the same time, and combine them into a single Transfer file (.blf).

 

c On the File menu, click Save Transfer File.

Important
The Save Transfer File menu option appears only if the P-touch labeling system is disconnected from the 
computer or is offline.

 

d In the Save as type field, select the BLF format from the drop-down menu, type the file name, and then 
click Save to save the template.
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This program allows you to use your computer to manage P-touch Template. 
You can use P-touch Library to print templates.

Starting P-touch Library 12

 For Windows 7:

Click  (Start) > All Programs > Brother P-touch > P-touch Tools > P-touch Library.

 For Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2:

Click P-touch Library on the Apps screen.

 For Windows 10:

Click  (Start) > All apps > P-touch Library under Brother P-touch.

When P-touch Library starts, the main window appears.

Main window 12

 

1 Menu bar
Provides access to all available commands, which are grouped under each menu title (File, Edit, View, 
Tool, and Help) according to their functions.

2 Toolbar
Provides access to frequently used commands.

How to Use P-touch 12

2

3

1

4

5
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3 Folder list
Displays a list of folders. When you select a folder, the templates in the selected folder appears in the 
templates list.

4 Templates list
Displays a list of the templates in the selected folder.

5 Preview
Displays a preview of the templates selected in the templates list.

Explanations of the Toolbar Icons

Icon Button name Function
 

Open Opens the selected template.

 

Print

(Only for P-touch Library)
Prints the selected template with the P-touch labeling system.

 

Search Allows you to search for templates registered to P-touch Library.

 

Display Style Changes the file display style.
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Opening and Editing Templates 12

Select the template you want to open or edit, and then click Open.
 

The program associated with the template starts so that you can edit the template.
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Printing Templates 12

Select the template you want to print, and then click Print.
 

The connected P-touch labeling system prints the template.
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Searching for Templates 12

You can search for templates registered to P-touch Library.

a Click Search.
The Search dialog box appears.
 

b Specify the search criteria.
The following search criteria are available:

Settings Details

Multiple Parameters Determines how the program searches when multiple criteria are specified. If you select 
AND, the program searches for files that satisfy all of the criteria. 
If you select OR, the program searches for files that satisfy any of the criteria.

Name Search for a template by specifying the file name.

Type Search for a template by specifying the file type.

Size Search for a template by specifying the file size.

Date Search for a template by specifying the file date.
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c Click Begin Search.
The search begins.

d Close the Search dialog box.
To confirm the search results, click Search Results in the folder view.

Note
You can register templates to P-touch Library by dragging and dropping them into the All Contents folder 
or to the folder list. You can also configure P-touch Editor to register templates to P-touch Library 
automatically, using the following procedure:

1 From the P-touch Editor menu, select Tools > Options.

2 In the Options dialog box, click Registration Settings in the General tab.

3 Select the timing for registering templates created with P-touch Editor, and then click OK.
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Transfer templates to the P-touch labeling system using P-touch Transfer Express. First, the administrator 
creates a template, and then distributes it together with P-touch Transfer Express. You can then use P-touch 
Transfer Express to transfer the template directly to your P-touch labeling system.

Important
• The printer driver must be installed before using Transfer Express.

• P-touch Transfer Express is available only in English.

• If the template is to be transferred as a new one, make sure you specify a Key Assign number (in P-touch 
Transfer Manager) that is not currently used. If the specified Key Assign number is already being used, 
the existing template will be overwritten with the new one.

• This function requires a USB connection.
 

Preparing P-touch Transfer Express 13

a Download the latest version of P-touch Transfer Express from the Brother support website at 
support.brother.com. Select your region/country, click Downloads, search for your product, and then go 
to Utilities to locate the file.

b Decompress the downloaded file (.zip).

Transferring Templates with P-touch 
Transfer Express 13

Administrator Users
 

Brother support website
support.brother.com

P-touch
 Editor

P-touch 
Transfer Manager

Transfer Express

xxx.lbx xxx.lbx xxx.pdz

1.

2. 3. 4. 5.

P-touch 
Transfer Express

xxx.pdz

https://support.brother.com/


Transferring Templates with P-touch Transfer Express 

147

13

Transferring the Template to P-touch Transfer Manager 13

a In P-touch Editor, open the template to be transferred.

b Click File > Transfer Template > Transfer.
 

The template is transferred to P-touch Transfer Manager.
P-touch Transfer Manager automatically starts up.

Note
Another way to transfer templates to P-touch Transfer Manager: 

• For Windows 7: 

Click  (Start) > All Programs > Brother P-touch > P-touch Tools > P-touch Transfer Manager. 

Drag the .lbx file to the P-touch Transfer Manager window.

• For Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2: 
Click P-touch Transfer Manager on the Apps screen to start P-touch Transfer Manager. Drag the .lbx 
file to the P-touch Transfer Manager window.

• For Windows 10: 

Click  (Start) > Brother P-touch > P-touch Transfer Manager. Drag the .lbx file to the P-touch 

Transfer Manager window.
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Saving the Template as a Transfer Package File (.pdz) 13

To create a file in a format that can be used by P-touch Transfer Express, save the template as a Transfer 
Package file (.pdz).

Before transferring templates, disconnect your Brother machine from your computer and/or make sure it is 
offline.

a In the folder view, select Configurations.
 

b Select the templates you want to distribute. You can select more than one template at a time and save 
them in the same package file (.pdz).
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c Click File > Save Transfer File.
 

Important
The Save Transfer File button appears only if the P-touch labeling system is disconnected from the 
computer or offline.

 

d Make sure the pdz is selected as the saved type, then type a file name, and then click Save.
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Distributing the Transfer Package File (.pdz) and P-touch 
Transfer Express to the User 13

Note
If the user already has P-touch Transfer Express downloaded, it is not necessary for the administrator to 
send the Transfer Express folder to the user. In this case, the user can simply move the distributed 
Transfer Package file to the downloaded folder, and then double-click PtTrExp.exe.

 

a Move the Transfer Package file (.pdz) to the downloads folder.
 

b Distribute all files in the downloads folder to the user.
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Transferring the Transfer Package File (.pdz) to Your P-touch 
Labeling System 13

Using the P-touch Transfer Express application received from the administrator, the user can transfer the 
Transfer Package file (.pdz) to the P-touch labeling system.

Important
Do not turn off the power when transferring templates.

 

a Turn on the P-touch labeling system.

b Using a USB Cable, connect the P-touch labeling system to the computer.

c Double-click PtTrExp.exe, which was received from the administrator.

d 1.When there is a single Transfer Package file (.pdz) within the folder containing PtTrExp.exe, click 
Transfer.
 

The transfer of the Transfer Package file begins.
 



Transferring Templates with P-touch Transfer Express 

152

13

2.When there are either multiple or no Transfer Package files (.pdz) within the folder containing 
PtTrExp.exe, click Browse.
 

Select the Transfer Package file you want to transfer, and then click Open.
 

Click Transfer.
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Click Yes.
 

The transfer of the Transfer Package file begins.
 

e Click OK.
 

The transfer of the Transfer Package file is completed.
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The software can be upgraded to the latest available version using the P-touch Update Software.

Note
• The actual software and the contents of this manual may differ.

• Do not turn off the power when transferring data or updating firmware.
 

Updating Cable Label Tool and P-touch Editor 14

Important
The printer driver must be installed before updating Cable Label Tool and P-touch Editor.

 

a Start the P-touch Update Software.

 For Windows 7:

Double-click the P-touch Update Software icon.

Note
The following method can also be used to start P-touch Update Software:

Click the Start button, and then select All Programs > Brother P-touch > P-touch Update Software.
 

 For Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2:

Click P-touch Update Software on the Apps screen.

 For Windows 10:

Click  (Start) > Brother P-touch > P-touch Update Software.

b Click the Computer software update icon.
 

How to Update P-touch Software 14
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c Select the Printer and Language settings, select the check box next to Cable Label Tool and P-touch 
Editor, and then click Install.
 

d A message appears indicating that the installation has finished.



How to Update P-touch Software 

156

14

Updating the Firmware 14

Important
• The printer driver must be installed before updating the firmware.

• Do not turn off the power when transferring data or updating firmware.

• If another application is running, exit the application.
 

a Turn on the P-touch labeling system and connect the USB Cable.

b Start the P-touch Update Software.

 For Windows 7:

Double-click the P-touch Update Software icon.

Note
The following method can also be used to start P-touch Update Software: 
Click the Start button, and then select All Programs > Brother P-touch > P-touch Update Software.

 

 For Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2:

Click P-touch Update Software on the Apps screen.

 For Windows 10:

Click  (Start) > Brother P-touch > P-touch Update Software.

c Click the Machine update icon.
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d Select the Printer settings, ensure that The machine is connected correctly. appears, and then click 
OK.
 

e Select the Language settings, select the check box next to the firmware you want to update to, and then 
click Transfer.

Important
Do not turn off the P-touch labeling system or disconnect the cable during data transfer.

 

 

f Check the content to be updated, and then click Start to begin the update. 
The firmware update begins.

Important
Do not turn off the P-touch labeling system or disconnect the cable during the update process.
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You must install P-touch software and the printer driver for your machine to use your P-touch labeling system 
with your computer.

Download the installer from install.brother.

For more information on installing the software and driver, see Installing the Printer Driver and Software 
on page 64.

To download the latest driver and software individually, visit the Brother support website at 
support.brother.com.

Select your region/country. > Downloads > Choose your product

Installing P-touch Software and Printer 
Driver 15

http://install.brother
https://support.brother.com/
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Starting P-touch Editor 16

a Double-click P-touch Editor icon on the desktop.

Note
• The following method can also be used to start P-touch Editor: 

Double-click Macintosh HD > Applications, and then double-click the P-touch Editor application icon.

• When using a Mac computer, you cannot transfer label data created using P-touch Editor to the P-touch 
labeling system.

 

P-touch Editor starts.

How to Use P-touch Editor 16
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16
Operation modes 16

Standard Mode 16

This mode allows you to create labels with text and images.

The layout window consists of the following sections:
 

* This screen may be different depending on your P-touch Editor version.

1 Command bar

2 Draw/Edit toolbar

3 Inspector

4 Layout window

5 Database window

1

2

5

4

3
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Snap mode (P-touch Editor 5.1 only) 16

With this mode, you can capture the screen, print it as an image, and save it for future use.

To start the Snap mode, follow the steps below.

a Click the Snap mode selection button.
The Description of Snap mode dialog box appears.
 

b Click OK.
The Snap mode palette appears.
 

Transferring Data to the P-touch Labeling System 16

To transfer data to the P-touch labeling system, you must use a Windows computer. For more information, 
see How to Use P-touch Transfer Manager on page 129.
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17

The software can be upgraded to the latest available version using the P-touch Update Software.

Note
• The actual software and the contents of this manual may differ.

• Do not turn off the power when transferring data or updating firmware.
 

Updating the Firmware 17

Important
• The printer driver must be installed before updating the firmware.

• Do not turn off the power when transferring data or updating firmware.

• If another application is running, exit the application.
 

a Turn on the P-touch labeling system and connect the USB Cable.

b Double-click the P-touch Update Software icon on the desktop.

Note
The following method can also be used to start P-touch Update Software:

Double-click Macintosh HD > Applications > P-touch Update Software, and then double-click the  
P-touch Update Software application icon.

 

 

How to Update P-touch Software 17
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c Click the Machine update icon.
 

d Select the Printer settings, ensure that The machine is connected correctly. appears, and then click 
OK.

e Select the Language settings, select the check box next to the firmware you want to update to, and then 
click Transfer.

Important
Do not turn off the P-touch labeling system or disconnect the cable during data transfer.

 

f Check the content to be updated, and then click Start to begin the update. 
The firmware update begins.

Important
Do not turn off the P-touch labeling system or disconnect the cable during the update process.
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18

Network Features 18

Your P-touch labeling system can be shared on an IEEE 802.11b/g/n wireless network using the internal 
network print server. The print server supports various functions and methods of connection on a network 
supporting TCP/IP, depending on the operating system you are running.

Introduction 18
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19

Changing Your P-touch Labeling System's Network Settings 
(IP Address, Subnet Mask and Gateway) Using Windows 19

Using the BRAdmin Light Utility 19

The BRAdmin Light utility is designed for the initial setup of Brother network connectable devices. It can also 
search for Brother products in a TCP/IP environment, display the status, and configure basic network 
settings, such as the IP address.

Installing BRAdmin Light 19

You must install BRAdmin Light to your computer. See Installing the Printer Driver and Software on page 64 
for more information on the installation.

To download the latest version of BRAdmin Light, visit the Brother support website at support.brother.com.

Note
• For more advanced printer management, use the latest version of the Brother BRAdmin Professional utility 

available as a download from the Brother support website at support.brother.com.

• If using firewall, anti-spyware, or antivirus software, temporarily disable them. When you are sure that you 
can print, re-enable them.

• The node name appears in the current BRAdmin Light window. The default node name of the print server 
in the printer is “BRWxxxxxxxxxxxx”. (“xxxxxxxxxxxx” is based on your printer's MAC Address / Ethernet 
Address.)

 

Setting the IP address, Subnet Mask and Gateway using BRAdmin Light 19

a Start the BRAdmin Light utility.

 For Windows 7:

Click  (Start) > All Programs > Brother > BRAdmin Light > BRAdmin Light.

 For Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2:

Click the BRAdmin Light icon on the Apps screen.

 For Windows 10:

Click  (Start) > Brother > BRAdmin Light.

b BRAdmin Light will search for new devices automatically.

Changing Your P-touch Labeling System 
Network Settings 19

https://support.brother.com/
https://support.brother.com/
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c Double-click the unconfigured device.
 

Note
If you do not use a DHCP/BOOTP/RARP server, the device appears as Unconfigured in the BRAdmin 
Light utility screen.

 

d Select STATIC for Boot Method. Type the IP Address, Subnet Mask, and Gateway settings (if 
needed) for your print server.
 

e Click OK.

f If you have set the IP address up correctly, the Brother print server appears in the device list.
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Other Management Utilities 19

Your P-touch labeling system can be used with the following management utilities in addition to the BRAdmin 
Light utility. Change your network settings using these utilities.

Using Web Based Management (Web Browser) 19

A standard web browser can be used to change your print server settings using the HTTP (Hyper Text 
Transfer Protocol) (for more information, see Configuring the Printer Settings Using Web Based Management 
(Web Browser) on page 171).

Using the BRAdmin Professional Utility (Windows Only) 19

BRAdmin Professional is a utility for more advanced management of network connected Brother devices. 
This utility can search for Brother products on your network, and display the device status from an easy to 
read Explorer style window that changes color to represent the status of each device. You can configure 
network and device settings along with the ability to update device firmware from a Windows computer on 
your Local Area Network (LAN). BRAdmin Professional can also log activity of Brother devices on your 
network and export the log data.

For more information and downloads, visit the Brother support website at support.brother.com.

Note
• Use the latest version of the BRAdmin Professional utility available as a download from the Brother 

support website at support.brother.com.

• If using firewall, anti-spyware, or antivirus software, temporarily disable them. When you are sure that you 
can print, re-enable them.

• The node name appears in the current BRAdmin Professional window. The default node name is 
“BRWxxxxxxxxxxxx”. (“xxxxxxxxxxxx” is based on your printer's MAC Address / Ethernet Address.)

 

https://support.brother.com/
https://support.brother.com/
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Overview 20

You can use a standard web browser to manage a P-touch labeling system on your network using HTTP. 
When using Web Based Management, the following operations are possible:

 Displaying your P-touch labeling system status information

 Changing network settings, such as TCP/IP information

 Displaying software version information of the P-touch labeling system and print server

 Changing network and P-touch labeling system configuration details

Note

We recommend Microsoft® Internet Explorer® 7.0 or later or Firefox® 25.0.1 or later for Windows, 

Safari® 5.0.6 or later or Firefox® 26.0 or later for Mac.

Make sure JavaScript and cookies are always enabled in the browser you use.
 

To use Web Based Management, your network must use TCP/IP, and the P-touch labeling system and 
computer must have a valid IP address.

Web Based Management 20
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Configuring the Printer Settings Using Web Based 
Management (Web Browser) 20

A standard web browser can be used to change your print server settings using the HTTP (Hyper Text 
Transfer Protocol).

Important
The default password is located on the back of the machine and marked "Pwd".
We recommend immediately changing the default password to protect your machine from unauthorized 
access. 

a Type “http://printer_ip_address/” into your browser's address bar. (Where “printer_ip_address” is your 
machine's IP address or the print server name.) For example, if the printer’s IP address is 192.168.1.2., 
type: http://192.168.1.2/.

b If required, type the password in the Login field.

c Click .

d Click the Network tab.

e Modify your machine's settings, if necessary.

Note
If you edited the Hosts file on your computer or are using a Domain Name System, you can also enter the 
print server's DNS name. The print server supports TCP/IP and NetBIOS, so you can also enter the print 
server's NetBIOS name. To find the NetBIOS name, click the Network tab and then select Network 
Status. The NetBIOS name assigned is the first 15 characters of the node name and appears as 
"BRWxxxxxxxxxxxx" (where "xxxxxxxxxxxxxxx" is the ethernet address).

You can also print the default password by pressing and holding the (Feed and Cut) button until the Label 
indicator starts flashing.

Note
Setting a password

We recommend setting a logon password to prevent unauthorized access to Web Based Management.

a Click Administrator.

b Type the password you want to use (up to 32 characters).

c Re-type the password in the Confirm new password field.

d Click Submit.
The next time you access Web Based Management, type a password in the Login field, and then 
click .
After configuring the settings, log off by clicking .

You can also set a password by clicking Please configure the password. on the printer's web page if you 
are not setting a logon password.
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21

Reset the internal memory of your P-touch labeling system to clear all saved label files, or if the P-touch 
labeling system is not operating correctly.

Resetting All Settings to the Factory Settings Using the 
P-touch Labeling System Buttons 21

All text, format settings, option settings and stored label files are cleared when you reset the P-touch labeling 
system (including language and unit settings).

To reset the P-touch labeling system, perform the following procedure.

a Turn off the P-touch labeling system.

b Press and hold the (Power) Button and the (Feed and Cut) Button for about three seconds until 
the (Power) indicator lights in orange and the  (Label) Indicator blinks in green.

c While holding the (Power) Button, press the (Feed and Cut) Button as follows:

 Press two times to reset the customized settings and clear the data except all of the transferred data 
from the computer, registered programs, and the contents in the file memory. (The settings that you 
can make using the Keyboard LCD Unit are reset.)

 Press four times to clear all of the transferred data from the computer, registered programs, and the 
contents in the file memory.

 Press six times to delete all data and reset the P-touch labeling system settings to the factory settings 
except the Wi-Fi settings.

d Release the (Power) Button.

Resetting the P-touch Labeling System 21
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Resetting Data Using the Settings in the Home screen 21

Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter key. 
Select Reset using the  or  key, and then press the OK or Enter key.

Resetting Data Using the Printer Setting Tool 21

Use the Printer Setting Tool from a computer to perform the following operations for the P-touch labeling 
system:

 Deleting the templates and databases

 Deleting the print log

 Resetting Wi-Fi settings

 Resetting printer settings to factory settings

For more information, see Changing System Settings on page 83.

Value Details

Reset All Settings Transferred data (templates, databases, and transferred symbols), registered 
programs and the contents in the file memory are NOT cleared.

Other data is cleared and all settings except the Wi-Fi settings are reset to 
factory settings.

Erase All Content Transferred data (templates, databases, and transferred symbols), registered 
programs and the contents in the file memory are cleared.

Other data is NOT cleared and settings are NOT reset.

Factory Default All data, customized settings, and the Wi-Fi settings are reset to factory 
settings.

Reset Wi-Fi Settings All Wi-Fi settings are reset to factory settings.
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22

We recommend cleaning your P-touch labeling system on a regular basis to maintain its correct performance 
and life span.

Note
Always remove the battery and disconnect the AC Adapter before cleaning the P-touch labeling system.

 

Cleaning the Unit 22

Wipe any dust and marks from the main unit using a soft, dry cloth.

Use a slightly dampened cloth on difficult to remove marks.

Note
Do not use paint thinner, benzene, alcohol or any other organic solvent. These may deform the case or 
damage the appearance of your P-touch labeling system.

 

Cleaning the Print Head 22

Streaks or poor quality characters on printed labels generally indicate that the Print Head is dirty. Clean the 
Print Head using a dry cotton swab or the optional Print Head cleaning cassette (TZe-CL6).
 

WARNING
 

Do not touch the Print Head directly with your bare hands. The Print Head may be hot.

 

Note
See the instructions provided with the Print Head cleaning cassette for directions on how to use it.

 

Maintenance 22
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Cleaning the Label Roller 22

If the quality of the printed characters on the labels is poor even after cleaning the Print Head, clean the entire 
label roller with a dry cotton swab by moving the swab up and down while rotating the roller.
 

Cleaning the Tape Cutter Unit 22

Tape adhesive can build up on the cutter blades after repeated use, dulling the blades, which may result in 
the tape jamming.

About once every year, wipe the cutter blades using a cotton swab.
 

WARNING
 

Do not touch the cutter blades directly with your bare hands.
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Cleaning the FLe Sensor 22

If the FLe sensor is dirty, FLe labels cannot be positioned correctly. Wipe the sensor using a cotton swab 
moistened with alcohol. 
 

Replacing the Coin Cell Battery 22

A Coin Cell Battery is used as a backup power supply to maintain the settings for the internal clock of the 
Keyboard LCD Unit. The battery will be consumed even if the P-touch labeling system is not used for a long 
period of time.

Important
• Use only recommended batteries in the P-touch labeling system. Other batteries may cause damage to 

the P-touch labeling system.

• When storing or discarding the battery, wrap it (for example with Cellophane Tape) to prevent it from 
short-circuiting.

(Battery insulation example)
 

1 Cellophane Tape

2 Coin Cell Battery

• We recommend replacing the battery every two years.

• If the clock is reset while power is supplied to the P-touch labeling system, replace this battery. When 
replacing the battery, buy a CR2032 battery (recommended manufacturers: Hitachi Maxell, Ltd., FDK 
Corporation).

• Dispose of the batteries at an appropriate collection point, not in the general waste stream. In addition, be 
sure to observe all applicable federal, state, and local regulations.

 

1

2



Maintenance 

178

22

a Press and hold the  (Power) Button to turn off the P-touch labeling system, and then disconnect the 
P-touch labeling system from the AC Power Outlet. If the rechargeable Li-ion battery is installed, remove 
the rechargeable battery.

b Press the Cover Open Button to open the Top Cover.

c Using a coin or similar object, slowly turn the Coin Cell Battery cover in the direction of the arrow on the 
battery cover until it stops to unlock, and then remove the Coin Cell Battery cover.
 

Important
If the Coin Cell Battery cover is forcibly turned past the stop position, it may become damaged.

 

d Remove the battery.
As shown below, press part A of the battery so that it can be removed.
 

e Install the new battery.

Important
Be sure to insert the new battery with the + and – sides facing the correct direction.

 

f Return the Coin Cell Battery cover to its original position. To install and lock the Coin Cell Battery cover, 
use a coin or similar object to slowly turn the Coin Cell Battery cover in the opposite direction of the arrow 
on the battery cover until it stops.
 

Important
If the Coin Cell Battery cover is forcibly turned past the stop position, it may become damaged.
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g Close the Top Cover.

Note
You can configure the time and date using [Settings] in the Home screen. For more information, see 
Clock Setting on page 29.
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Auto Power-Off Time 23

Your P-touch labeling system has a power saving function that automatically turns itself off if no key is 
pressed within a certain time, under certain operating conditions.

If you use the AC Adapter or rechargeable Li-ion battery, you can change the setting of the auto power-off 
time.

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Auto Power Off] using the  or  key, and then press the OK or Enter key.

c Select [AC Adapter] or [Li-ion Battery] using the  or  key and set the value using the  or  
key.

d Press the OK key.

You can also use the Printer Setting Tool to change the settings. See Changing System Settings on page 83 
for more information.

Important
• If you connect the AC Adapter to the P-touch labeling system after you specified "Auto Power Off", the 

machine uses the "AC Adapter" setting.

• The factory setting is "1 h" for the AC Adapter and "30 min" for the rechargeable Li-ion battery.
 

Useful Settings 23

Setting Value Setting Value

AC Adapter Off Li-ion Battery Off

10 min 10 min

20 min 20 min

30 min 30 min

40 min 40 min

50 min 50 min

1 h 1 h

2 h

4 h

8 h

12 h
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Adjusting the LCD Settings 23

Press the Esc key to return to the previous step.

LCD Contrast 23

You can change the contrast setting of the LCD to one of five levels (+2, +1, 0, -1, or -2) to make the screen 
easier to read. The factory setting is “0”.

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [LCD Contrast] using the  or  key, and then press the OK or Enter key.

c Set the value using the  or  key, and then press the OK or Enter key.

Note
Pressing the Space key on the contrast setting screen sets the contrast to the factory setting of “0”.

 

Backlight 23

You can change the backlight setting either to "On" or "Off".

The display is easier to see with the backlight on. The factory setting is "On".

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Backlight] using the  or  key, and then press the OK or Enter key.

c Select [On] or [Off] using the  or  key, and then press the OK or Enter key.

Note
• Power can be saved when the backlight is turned off.

• The backlight automatically turns off. Press any key to turn the backlight on again.
 

During printing, the backlight is turned off. The backlight turns on during data transmissions.



Useful Settings 

182

23

Setting Language and Unit 23

Press the Esc key to return to the previous step.

Language 23

a Select Settings in the Home screen using the , ,  or  key, and then press the OK or Enter key.

b Select [  Language] using the  or  key, and then press the OK or Enter key.

c Select a language for menu commands and messages shown on the LCD using the  or  key.
The following languages are available: [Čeština], [Dansk], [Deutsch], [English], [Español], 
[Français], [Hrvatski], [Italiano], [Magyar], [Nederlands], [Norsk], [Polski], [Português], 
[Português (Brasil)], [Română], [Slovenski], [Slovenský], [Suomi], [Svenska], and [Türkçe].

d Press the OK or Enter key.

Setting Unit 23

a Select [Settings] in the Home screen using the , ,  or  key, and then press the OK or Enter 
key.

b Select [Unit] using the  or  key, and then press the OK or Enter key.

c Select a unit for dimensions shown on the LCD using the  or  key.
Either [inch] or [mm] can be selected.

d Press the OK or Enter key.

Note
The factory setting is [inch].
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This P-touch labeling system can be powered by the AC Adapter (included) or the rechargeable Li-ion battery 
(optional: PA-BT-4000LI). Use the power source appropriate for your intended use.

With the rechargeable Li-ion battery installed, you can use the P-touch labeling system in locations that do 
not have AC power.

The battery is recharged by the AC Adapter when the battery installed to the P-touch labeling system.

Installing the Rechargeable Li-ion Battery 24

a Press and hold the  (Power) Button to turn off the P-touch labeling system.

b Open the battery cover on the bottom of the P-touch labeling system.

c Insert the battery into the battery compartment.

d Close the battery cover.
 

Note
The voltage supplied by the rechargeable Li-ion battery fluctuates. The printing speed may also fluctuate 
depending on the voltage.

 

Using the Rechargeable Li-ion Battery 
(Optional: PA-BT-4000LI) 24
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Removing the Rechargeable Li-ion Battery 24

Press and hold the  (Power) Button to turn off the P-touch labeling system.

Remove the battery cover and the battery, and then reattach the battery cover.

CAUTION
 

If it is difficult to remove the rechargeable battery, turning the P-touch labeling system over with the battery 
cover removed may allow the rechargeable battery to fall out. 
Be careful that this does not cause any injuries.

 

Charging the Rechargeable Li-ion Battery 24

Note
• Before use, fully charge the battery.

• Up to three hours may be needed to fully charge the battery.
 

a Make sure the battery is installed in the P-touch labeling system.

b Use the AC Adapter and Power Supply Cord to connect the P-touch labeling system to an AC Power 
Outlet.

Press the  (Power) Button to turn on the P-touch labeling system if it is not on already.
The  (Battery) Indicator lights in orange during charging, and it goes off when the battery is fully 
charged.
 

1 AC Adapter

2 Power Supply Cord

Note
• Even if the P-touch labeling system is turned off during charging, the charging will continue until the battery 

is fully charged.

1

2
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• If the P-touch labeling system is turned on with the rechargeable Li-ion battery installed and the AC 
Adapter connected to an AC Power Outlet, the battery will be recharged. However, when the P-touch 
labeling system is turned on, even after the rechargeable battery has been charged, the battery charge 
will be used, leaving the battery with less than a full charge the next time the P-touch labeling system is 
used. We recommend leaving the P-touch labeling system turned off while charging the battery.

• Although the charging stops if the P-touch labeling system is used to print, feed, or perform another 
operation, the charging will start again automatically after the operation is finished if the charging is not 
completed.

 

Stopping Rechargeable Li-ion Battery Charging 24

To stop the battery charging, disconnect the AC Adapter.

Notes on Using the Rechargeable Li-ion Battery 24

 Before use, fully charge the battery. Do not use it until it is fully charged.

 The battery charging must take place in environments between 32°F and 104°F (0°C and 40°C), otherwise 
the battery will not charge, and the  (Battery) Indicator will remain lit. If the charging stops because the 
environment temperature is too low or too high, place the P-touch labeling system with a temperature 
between 32°F and 104°F (0°C and 40°C) and try charging again.

 If the P-touch labeling system is used to print, feed, or perform another operation when both the battery is 
installed and the AC Adapter is connected, the  (Battery) Indicator may turn off and charging may stop 
even if the battery is not fully charged.

Rechargeable Li-ion Battery Characteristics 24

To ensure the highest performance and longest life from the battery:

 Do not use or store the battery in a location exposed to extreme high or low temperatures as it may 
discharge more quickly. This may happen when using a rechargeable Li-ion battery with a high charge 
(90% charged or more) in a location exposed to high temperatures.

 Remove the battery when storing the P-touch labeling system for long periods of time.

 Store a battery with less than a 50% charge in a cool dry place out of direct sunlight.

 Recharge the battery every six months if it is stored for long periods of time.

 If you touch a part of the P-touch labeling system while the rechargeable Li-ion battery is charging, that 
part of the P-touch labeling system may feel warm. This is normal, and the P-touch labeling system may 
be used safely. However, if the P-touch labeling system becomes extremely hot, discontinue use.



Using the Rechargeable Li-ion Battery (Optional: PA-BT-4000LI) 

186

24

Product Specifications 24

Rechargeable Li-ion Battery 24

Size: approx. 2.92" (W) x 3.39" (D) x 1.26" (H) (74 mm (W) x 86 mm (D) x 32 mm (H))

Weight: approx. 0.53 lb (0.240 kg)

Voltage: 14.4 V

Capacity: 1800 mAh

Charging/discharging cycle: approx. 300 times

Charging time: approx. 3 hours
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Overview 25

This chapter explains how to resolve typical problems you may encounter when using the P-touch labeling 
system. If you have any problems with the P-touch labeling system, first make sure you have performed the 
following tasks correctly:

 Connect the P-touch labeling system to an AC Power Outlet or install the battery (for more information, 
see Connecting the Power Supply on page 5 or Installing the Rechargeable Li-ion Battery on page 183).

 Remove all protective packaging from the P-touch labeling system.

 Install and select the correct printer driver (for more information, see Installing the Printer Driver and 
Software on page 64).

 Connect the P-touch labeling system to a computer or mobile device (for more information, see 
Connecting the P-touch Labeling System to a Computer on page 64).

 Close the Top Cover completely.

 Insert a Tape Cassette correctly (for more information, see Inserting a Tape Cassette on page 6).

If you still have problems, read the troubleshooting tips in this chapter for help. If, after reading this chapter, 
you are unable to resolve your problem, visit the Brother support website at support.brother.com.

Troubleshooting 25

https://support.brother.com/
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LCD Problems 25

Printing Problems 25

Problem Solution

The screen is locked, or the P-touch 
labeling system does not respond 
normally.

See Resetting the P-touch Labeling System on page 173 and reset the internal 
memory to the factory settings. If resetting the P-touch labeling system does 
not solve the problem, disconnect the AC Adapter and remove the battery for 
more than 10 minutes.

The display remains blank after 
turning on the power.

The POWER indicator does not light.

The P-touch labeling system is receiving no power.

If using AC power, connect the AC Adapter correctly to the P-touch labeling 
system and an AC Power Outlet.

If using a rechargeable Li-ion battery, make sure the rechargeable Li-ion 
battery is firmly installed in the P-touch labeling system and is fully charged.

Check that the Keyboard LCD Unit Cable is securely connected to the 
Keyboard LCD Unit and Keyboard LCD Unit interface of the P-touch labeling 
system.

The LCD messages appear in a 
foreign language.

See Language on page 182 to select the language you want.

Problem Solution

The label is not printed.  Check that text has been entered and that the Tape Cassette is installed 
correctly with sufficient tape remaining.

 If the tape is bent, cut off the bent section and thread the tape through the 
exit slot or Tape Guides.

 When printing from a computer or mobile device, make sure the computer 
or mobile device is connected correctly to the P-touch labeling system.

The label is not printed correctly.  Remove the Tape Cassette and reinstall it, pressing it firmly until it locks into 
place.

 If the Print Head is dirty, clean it with a dry cotton swab (for more 
information, see Cleaning the Print Head on page 175) or optional Print 
Head cleaning cassette (TZe-CL6).

If the quality of the printed characters is poor even after wiping the label 
Print Head, wipe the label roller with a dry cotton swab. For more 
information, see Cleaning the Label Roller on page 176.
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The tape is jammed.  If the tape is jammed, remove the Tape Cassette from the P-touch labeling 
system.

 Check the Tape Cassette Compartment and Tape Exit Slot for tape scraps, 
jammed tape or debris that may prevent the tape from correctly exiting the 
machine.  Remove if present.

 Examine the Tape Cassette and cut away any damaged tape that is present 
past the Tape Guides on the Tape Cassette.

 Check that the end of the tape is not bent and that is passes through the 
Tape Guides. For more information, see Inserting a Tape Cassette 
on page 6.

 Insert the Tape Cassette into the Tape Cassette Compartment.

The ink ribbon is separated from the 
ink roller.

If the ink ribbon is broken, replace the Tape Cassette. If not, leave the tape 
uncut and remove the Tape Cassette, then wind the loose ink ribbon onto the 
spool as shown in the figure.
 

1 Spool

Note
Do not pull the label when the P-touch labeling system is ejecting it from the 
Tape Exit Slot. Doing so will cause the ink ribbon to be pulled out with the 
tape. The tape may no longer be functional after the ink ribbon is pulled out.

 

The P-touch labeling system stops 
while printing a label.

 Replace the Tape Cassette if striped tape is visible, as this indicates that 
you have reached the end of the tape.

 Connect the AC Adapter directly to the P-touch labeling system, or charge 
the rechargeable Li-ion battery.

The label is not cut automatically. Check the Cut Option setting. For more information, see Tape Cutting Options 
on page 43 or Cutting Options on page 73.

To cut labels manually, press the (Feed and Cut) Button to feed and cut the 
tape.

A tape jam error cannot be cleared 
despite following the troubleshooting 
steps.

Contact Brother customer service.

I want to make fine adjustments to 
the print result.

The length and margins can be adjusted in the Printer Setting Tool. For more 
information, see Changing System Settings on page 83.

I want to print faster. High speed printing can be used if you are printing from a computer, the AC 
Adapter is connected, and TZe and HGe laminated tape with black ink is 
installed. Use the printer driver to select the high speed mode when printing the 
labels.

You cannot use this function for TZe-FX**1 tape.

Problem Solution

1
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I want to print in higher resolution. High resolution printing can be used if you are printing from a computer, the AC 
Adapter is connected, and TZe and HGe laminated tape with black ink is 
installed. Use the printer driver to select the high resolution mode when printing 
the labels.

You cannot use this function for TZe-FX**1 tape.

The print result is poor. High resolution printing can be used if you are printing from a computer, the AC 
Adapter is connected, and TZe and HGe laminated tape with black ink is 
installed. Use the printer driver to select the high resolution mode when printing 
the labels.

You cannot use this function for TZe-FX**1 tape.

If using the high speed printing setting, print using the standard setting.

The high resolution or high speed 
printing setting was specified, but an 
error occurred and printing could not 
be completed.

As conditions for high resolution or high speed printing, you must print from a 
computer, the AC Adapter must be connected, and TZe and HGe laminated 
tape with black ink must be installed.

You cannot use this function for TZe-FX**1 tape.

To clear the error, cancel the print job, and then connect the AC Adapter or 
cancel high resolution or high speed printing.

Problem Solution
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Printed barcodes cannot be read.  Print labels so that barcodes are aligned with the Print Head as shown 
below:
 

1 Print Head

2 Barcode

3 Printing orientation

 Try using another scanner.

 We recommend printing the barcodes with Standard selected from the 
Quality options.

• Windows 7:

To display the Quality options, open the printer properties by clicking the 
Start button > Devices and Printers, right-clicking the printer you want 
to set up, and then clicking Printing Preferences. 

• Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2:

To display the Quality options, open the printer properties by clicking 
Control Panel in the Apps screen > Hardware and Sound > Devices 
and Printers, right-clicking the printer you want to set up, and then 
clicking Printing Preferences.

• Windows 10:

To display the Quality options, open the printer properties by clicking the 
Start button > Settings > Devices > Devices and Printers, 
right-clicking the printer you want to set up, and then clicking Printing 
Preferences.

FLe labels cannot be positioned 
correctly.

If the FLe sensor is dirty, FLe labels cannot be positioned correctly. Wipe the 
FLe sensor using a cotton swab moistened with alcohol to clean the sensor. 
For more information, see Cleaning the FLe Sensor on page 177.

Jams occur when I use TZe-R*** 
tape cassettes.

Remove the TZe-R*** Tape Cassette from the printer, and then remove the 
jammed ribbon.

Because the material used for the TZe-R*** ribbon is light and flexible, the 
ribbon may jam if it contacts the parts of the Tape Exit Slot.

When using TZe-R*** tape cassettes, position the printer so that the ribbon 
exits straight out of the Tape exit slot. In addition, make sure the discharged 
ribbon does not hang down from the printer. The ribbon may jam if it touches 
the Tape Exit Slot.

In addition to these precautions, do not touch the ribbon during printing.

Problem Solution

1

2

3
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Version Information 25

Problem Solution

I do not know the version number of 
the firmware of my P-touch labeling 
system.

The version number and other information for the firmware can be confirmed 
using the following procedure:

1 Select [Settings] in the Home screen using the , ,  or  key, and 
then press the OK or Enter key.

2 Select [Version Information] using the  or  key, and then press the 
OK or Enter key.

In addition, you can also use the following procedure. 

1 Turn on the P-touch labeling system.

2 Press and hold the  (Feed and Cut) Button for more than 10 seconds to 
print the report. For more information, see Confirming System Settings 
on page 105. 
(Use 0.94" (24 mm) or 1.4" (36 mm) tape.)

I want to confirm whether I am using 
the latest version of the software.

Use the P-touch Update Software to confirm if you have the latest version.

See How to Update P-touch Software on page 154 for more information about 
the P-touch Update Software.
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Network Setup Problems 25

Problem Solution

You are using security software  Confirm your settings in the installation dialog box.

 Allow access when the security software alert message appears during the 
printer installation.

Your security settings 
(SSID/Network Key) are incorrect

Recheck and select the correct security settings.

 The manufacturer's name or model number of the wireless access 
point/router may be used as the default security settings.

 See the instructions supplied with your wireless access point/router for 
information on how to find the security settings.

 Ask the manufacturer of your wireless access point/router or ask your 
Internet provider or network administrator.

Your P-touch labeling system is 
placed too far from your mobile 
device

Move your P-touch labeling system within about 3.3 ft (1 m) of the mobile 
device when you configure the Wi-Fi network settings.

There are obstructions (walls or 
furniture, for example) between your 
P-touch labeling system and the 
mobile device

Move your P-touch labeling system to an obstruction-free area.

A wireless computer, Bluetooth 
supported device, microwave oven 
or digital cordless phone is near the 
P-touch labeling system or the 
wireless access point/router

Move other devices away from the P-touch labeling system.

You are using MAC Address filtering Confirm the MAC address by printing the P-touch labeling system settings 
report.

See Confirming System Settings on page 105 for more information.

Your wireless access point/router is 
in stealth mode (not broadcasting the 
SSID)

 You must type the correct SSID name during the installation or when using 
the Printer Setting Tool.

 Check the SSID name in the instructions supplied with your wireless access 
point/router and reconfigure the Wi-Fi settings.

Your P-touch labeling system is not 
connected correctly to the network

Check the wireless connection indicator on the LCD.

: Connected in Wi-Fi mode.

: Disconnected in Wi-Fi mode, so the wireless settings must be 
reconfigured.

: Connected or disconnected in Wireless Direct mode.

I have checked and tried all of the 
above, but still cannot complete the 
Wi-Fi settings

Turn off the P-touch labeling system, and then turn it on again. Then try and 
configure the Wi-Fi settings again.
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P-touch Labeling System Cannot Print over the Network 
P-touch Labeling System Is Not Found on the Network Even after Successful 
Installation 25

Security Software Problems 25

Problem Solution

You are using security software See Security Software Problems on page 194.

Your P-touch labeling system is not 
assigned with an available IP 
address

 Confirm the IP address and the Subnet Mask.

Verify that both the IP addresses and Subnet Masks of your computer and 
your P-touch labeling system are correct and located on the same network.

For more information on how to verify the IP address and the Subnet Mask, 
ask the network administrator.

 Confirm your IP address, Subnet Mask and other network settings using the 
Printer Setting Tool.

For more information, see Changing System Settings on page 83.

Your previous printing job failed  If the failed printing job is still in your computer's print queue, delete it.

For example, when using Windows 7:

The Start button, Devices and Printers and select your printer from 
Printers and Faxes. Double-click your printer's icon, and then select 
Cancel All Documents in the Printer menu.

I have checked and tried all of the 
above, but my P-touch labeling 
system does not print

Uninstall the printer driver and the software, and then reinstall them.

Problem Solution

You did not select to allow access 
when the security alert dialog box 
appeared during either the standard 
installation, BRAdmin Light 
installation, or when printing

If you did not select to allow access when the security alert dialog box 
appeared, the firewall function of your security software may be blocking 
access. Some security software may block access without displaying a security 
alert dialog box. To allow access, see the instructions of your security software 
or ask the manufacturer.

Incorrect port numbers are being 
used for the Brother network features

The following port numbers are used for Brother network features:

 BRAdmin Light i Port number 161 / Protocol UDP

For more information on how to open the port, see the instructions for the 
security software or ask the manufacturer.
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Checking the Operation of Network Devices 25

Problem Solution

Your P-touch labeling system and 
wireless access point/router are not 
turned on

Make sure you have performed all of the tasks on page 187.

I do not know my P-touch labeling 
system network settings, such as the 
IP address

Check the Printer Setting Tool (for more information, see Changing System 
Settings on page 83).

Can you ping your P-touch labeling 
system from your computer?

Ping your P-touch labeling system from your computer using the IP address or 
the node name.

 Successful: Your P-touch labeling system is working correctly and 
connected to the same network as your computer.

 Unsuccessful: Your P-touch labeling system is not connected to the same 
network as your computer.

Contact the network administrator.

Comfirm the IP address or the node name by printing the P-touch labeling 
system settings report.

See Confirming System Settings on page 105 for more information.
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Error Messages 25

When an error message appears on the display, follow the directions provided below.

Message Solution

Tape Removed!  Do not remove the Tape Cassette while printing.

Text Too Large!  Select a smaller font size.

 The size of transferred symbols has exceeded the label width when the 
P-touch labeling system is printing the symbols using the vertical 
orientation. Create the transferred symbol data using a size that fits in the 
label you are using.

Unable to use 01!  MRAM error. Turn off the P-touch labeling system, and then on again.

Unable to use 02!  The print head setting is incorrect. Turn off the P-touch labeling system, and 
then on again.

High Res/Speed Print Not 
Available!

 When using high resolution or high speed printing, you must connect the AC 
Adapter and use only TZe and HGe laminated tape with black ink, and print 
from the computer. Otherwise, print using the standard setting.

You cannot use this function for TZe-FX**1 tape.

Holder Malfunction! (Label)  The operation of the label feeding mechanism is faulty. Turn off the P-touch 
labeling system, and then on again. Check that the Tape Cassette is 
installed correctly. If the error continues, contact Brother customer service.

Adapter Connected or 
Disconnected!

 This message appears if you connect or disconnect the AC Adapter during 
printing. To clear the error and print the print job again, press and hold a 

button other than the  (Power) Button. To cancel the print job, press and 

hold the  (Power) Button.

File Transfer Failed!  The model name set for the sent file is incorrect. Create the file using the 
correct model name.
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LED Indicators 25

The indicators light and flash to indicate the P-touch labeling system status. The symbols used in this section 
explain the meaning of the different indicator colors and patterns:

 or  or Indicator is lit in the color shown

 or  or Indicator is flashing in the color shown

Indicator can be off, lit or flashing in any color

Indicator is off

Label, Power indicator

 (Label)  (Power) Condition

Power is turning off

Top Cover open

Idle mode

Initializing mode

Tape feed and cutting mode

(1 time in 1 second)
Transferring data

Now cooling

System error 1

System error 2

System error 3

(1 time in 1 second)

USB host power supply excessive voltage error

Mass storage error

(1 time in 2 seconds)
Label holder error

(2 times in 1.8 seconds)
Adapter error

In boot mode

Reset mode 

(when the mode is starting)
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Reset mode 

(when the button is pressed 2/4/6 times)

(Three times) (Three times)

Reset mode

(when reset is confirmed)

Mass storage mode

(Once)
Mass storage processing mode

Printing mode

(1 time in 1 second)
Receiving data

(2 times in 1.8 seconds) (2 times in 1.8 seconds)

Memory full error

Communication error

When blinking alternately: Cutter error

When blinking simultaneously: 

High temperature error

(2 times in 1.8 seconds)
Non-compliant tape error

(1 time in 1 second)
Wrong media error

(2 times in 1.8 seconds)

No cassette error

Media end error

Top Cover open error when printing

(2 times in 1.8 seconds) (2 times in 1.8 seconds)
High resolution/high speed printing error

Black mark not detected error

Label, Power indicator

 (Label)  (Power) Condition
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Battery indicator

 (Battery)  (Power) Condition

Rechargeable battery power: full

Charging

(1 time in 4 seconds)
Rechargeable battery power: half

(2 times in 4 seconds)
Rechargeable battery power: low

Rechargeable battery error

Rechargeable battery power: empty

Adapter connection/disconnection error

Wi-Fi indicator

 (Wi-Fi)  (Power) Condition

No available WPS access point was found

(1 time in 1 second)

WPS access point connection error

Check the protocol.

(2 times in 1.8 seconds)
Incorrect security settings

(2 times in 1.8 seconds)
WPS access point search error

Wi-Fi on, not connected

Wi-Fi on, connected

Wi-Fi off
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Indicator Warnings 25

Problem Solution

Received data in buffer Print data is saved in the buffer. If the P-touch labeling system has 
not received the complete data, printing will not start.

Turn off the P-touch labeling system, and then turn it on again.

Head is cooling down The thermal head is too hot.

The P-touch labeling system stops and resumes printing only after 
the thermal head has cooled down. The head may become too hot 
if you are printing a large number of labels.

When the thermal head becomes too hot, it may produce imaging 
on the labels in areas not intended to be printed. To avoid or delay 
overheating, make sure the P-touch labeling system has adequate 
ventilation and is not located in an enclosed space.

If the P-touch labeling system must cool down because it 
overheated due to the type of Tape Cassette you are using or the 
contents of the label, printing may take longer than usual.

Note
This condition may occur more often when the P-touch labeling 
system is used at high altitude (more than 10,000 ft (3,048 m)) 
due to a lower air density available to cool the P-touch labeling 
system.

 

P-touch labeling system is in boot mode To resolve the issue, contact your Brother dealer or Brother 
customer service for assistance.

Errors concerning tape cassettes Check the following:

 You are using the correct Tape Cassette.

 There is enough tape remaining.

 The Tape Cassette is installed correctly.

I want to reset an error I want to reset an error

1 Open the Top Cover, and then close it.

2 If the error is not reset, press the  (Feed and Cut) Button.

3 If the error still is not reset, turn off the P-touch labeling system, 
and then turn it on again.

4 If the error still is not reset, contact Brother customer service.
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P-touch Labeling System Specifications 26

Product Specifications 26

Model Name PT-D800W

Size
Dimensions approx. 13.31" (W) x 7.40" (D) x 6.81" (H) (338 mm (W) × 188 mm (D) × 173 mm (H))  

(including keybord LCD unit)

Weight approx. 7.50 lb (3.4 kg) (including keybord LCD unit)

Printing
Method Thermal Transfer

Print Head 454 dot/360 dpi

High resolution mode: max. 720 dpi × 360 dpi (when connected to a computer) 1

Print height 1.26" (32 mm) max. (when using 1.4" (36 mm) tape) 2

Print speed AC Adapter: max. 2.3"/sec. (60 mm/sec.)

Battery: 0.78"/sec. - 2.3"/sec. (20 mm/sec. - 60 mm/sec.) (varies depending on the 
tape width)

Actual print speed varies depending on the conditions.

Cassette Brother TZe Tape Cassette : 0.13" (3.5 mm), 0.23" (6 mm), 0.35" (9 mm), 0.47" (12 
mm), 0.70" (18 mm), 0.94" (24 mm), 1.4" (36 mm)

Brother HGe Tape Cassette : 0.23" (6 mm), 0.35" (9 mm), 0.47" (12 mm), 0.70" (18 
mm), 0.94" (24 mm), 1.4" (36 mm)

Brother HSe tube cassette : 0.23" (5.8 mm), 0.34" (8.8 mm), 0.46" (11.7 mm), 0.69" 
(17.7 mm), 0.93" (23.6 mm)

Brother FLe label cassette : 0.82" (21 mm) × 1.77" (45 mm)

No. of lines  TZe Tape Cassette

1.4" (36 mm) tape: 17 lines; 0.94" (24 mm) tape: 13 lines; 0.70" (18 mm) tape: 10 
lines; 0.47" (12 mm) tape: 6 lines; 0.35" (9 mm) tape: 4 lines; 0.23" (6 mm) tape: 3 
lines; 0.13" (3.5 mm) tape: 1 line

 HGe Tape Cassette

1.4" (36 mm) tape: 17 lines; 0.94" (24 mm) tape: 13 lines; 0.70" (18 mm) tape: 10 
lines; 0.47" (12 mm) tape: 6 lines; 0.35" (9 mm) tape: 4 lines; 0.23" (6 mm) tape: 3 
lines

 HSe Tube Cassette

0.93" (23.6 mm) tape: 12 lines; 0.46" (11.7 mm) tape: 10 lines; 0.46" (11.7 mm) 
tape: 6 lines; 0.34" (8.8 mm) tape: 4 lines; 0.23" (5.8 mm) tape: 2 lines

Memory (local files)
File storage max. 99 files
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1 The high resolution mode can be used if the AC Adapter is connected and TZe and HGe laminated tape with black ink is installed.
You cannot use this function for TZe-FX**1 tape.

2 Actual character size may be smaller than maximum print height.
3 Not all computers, mobile devices, and operating systems, may support Ad-hoc mode.

Power Supply
Adapter AC Adapter (AD9100ESA): 24 V AC 120 V 60 Hz

Battery Rechargeable Li-ion Battery (PA-BT-4000LI): 14.4 V

Auto Power-off Rechargeable Li-ion Battery (PA-BT-4000LI): 30 min

AC Adapter (AD9100ESA): 1 h

(To change the Auto Power-off setting, see Auto Power-Off Time on page 180.)

Interface
USB Version 2.0 Full Speed (Peripheral)

Wi-Fi  Wireless Direct: IEEE 802.11n

 Ad-Hoc mode 3: IEEE 802.11b

 Infrastructure mode: IEEE 802.11b/g/n

 WPS 2.0

Other
Operating

temperature/humidity

When running: between 50°F and 95°F (10°C and 35°C) / between 20% and 80%

max. wet bulb temperature: 80.6°F (27°C)

Model Name PT-D800W
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Operating Environment 26

The compatible operating systems may change. For the latest information, visit our support website at 
support.brother.com.

 Brother support website

Please visit our support website at support.brother.com.

You can find following information:

• Software downloads

• Manuals/Documents

• Frequently Asked Questions (Troubleshooting, Useful tips on using printer)

• Consumable information

• Latest OS compatibility information

The contents of this website are subject to change without notice.

Item Specifications

Operating System Windows Windows 7 / Windows 8.1 / Windows 10 /  Windows Server 2012 / 
Windows Server 2012 R2 / Windows Server 2016 / Windows 
Server 2019

Mac macOS v10.13.6 / 10.14.x / 10.15

Hard Disk Windows Disk space: 460 MB or more

Mac Disk space: 500 MB or more

Memory Windows Windows Server 2012 / Windows Server 2012 R2 / Windows 
Server 2016 / Windows Server 2019: 512 MB or more

Windows 7 / Windows 8.1 / Windows 10: 1 GB or more (32-bit) or 
2 GB or more (64-bit)

Mac macOS v10.13.6 / 10.14.x / 10.15: 2 GB or more

https://support.brother.com/
https://support.brother.com/
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Since some P-touch Editor functions are not available with the P-touch labeling system, keep the following 
points in mind when using P-touch Editor to create templates.

To check a preview of the printed template before the created template is transferred to the P-touch labeling 
system, see Transferring Templates to P-touch Transfer Manager on page 129.

Notes on Creating Templates 27

 The P-touch labeling system is loaded with 14 fonts. Some of the text in the template that is transferred to 
the P-touch labeling system will be printed using similar fonts and character sizes that are loaded in the 
P-touch labeling system. As a result, the printed label may differ from the image of the template created 
in P-touch Editor.

 Depending on the text object setting, the character size may be automatically reduced or some of the text 
may not be printed. If this occurs, change the text object setting.

 Although character styles can be applied to individual characters with P-touch Editor, styles can be applied 
to a block of text only with the P-touch labeling system. In addition, some character styles are not available 
on the P-touch labeling system.

 A numbering field specified with P-touch Editor cannot be transferred.

 Backgrounds specified with P-touch Editor are not compatible with the P-touch labeling system.

 A P-touch Editor layout that uses the split printing function (enlarging the label and printing it on two or 
more labels) cannot be transferred.

 Only the first 17 lines of text typed in a database field are read by the P-touch labeling system.

 Fields that overflow the print area may not be printed completely.

Notes on Transferring Templates 27

 The printed label may differ from the image that appears in the preview area of P-touch Transfer Manager.

 If a barcode not loaded on the P-touch labeling system is transferred to the P-touch labeling system, the 
barcode will be converted into an image if it is a 2-dimensional barcode. The image of the converted 
barcode cannot be edited. If the template contains a 1-dimensional barcode that was rotated, an error will 
occur and the template cannot be transferred.

 All transferred objects that cannot be edited by the P-touch labeling system are converted into images.

 Grouped objects will be converted into a single bitmap, from which the data cannot be edited with the 
P-touch labeling system keyboard.

Notes on Using P-touch Transfer 
Manager 27
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Notes on Transferring Data Other Than Templates 27

 If the number or order of fields in a database is changed and only the database (*.csv file) is transferred 
to update it, the database may not link correctly with the template. In addition, the first line of data in the 
transferred file must be recognized by the P-touch labeling system as "field names".

 Logos, symbols, and graphics downloaded to the P-touch labeling system will automatically be scaled like 
the resident font or any of the resident symbol in the library.
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Supported Protocols and Security Features 28

Network Terms and Information 28

Interface Wireless IEEE 802.11b/g/n (Infrastructure mode)

IEEE 802.11b (Ad-Hoc mode)

IEEE 802.11n (Wireless Direct mode)

Network 
(Common)

Protocol (IPv4) ARP, RARP, BOOTP, DHCP, APIPA (Auto IP), mDNS, WINS, 
NetBIOS name resolution, DNS Resolver, LPR/LPD, Custom Raw 
Port/Port9100, FTP Server, TFTP client and server, SNTP client, 
ICMP, LLMNR responder, SNMPv1/v2c

Protocol (IPv6) NDP, RA, DNS Resolver, LPR/LPD, mDNS, Custom Raw 
Port/Port9100, FTP Server, SNMPv1, TFTP client and server, ICMP, 
LLMNR responder, SNMPv1/v2c

Network 
(Security)

Wireless SSID (32 chr), WEP 64/128 bit, WPA/WPA2-PSK, LEAP, EAP-FAST, 
PEAP, EAP-TTLS, EAP-TLS
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Types of Network Connections and Protocols 28

You will find basic information about the advanced network features of the Brother P-touch labeling system, 
along with general networking and common terms.

The supported protocols and network features differ depending on the model you are using.

Types of Network Connections 28

Peer-to-Peer printing using TCP/IP 28

In a Peer-to-Peer environment, each computer directly sends and receives data to each device. There is no 
central server controlling file access or printer sharing.
 

1 Router

 In a smaller network of two or three computers, we recommend the Peer-to-Peer printing method as it is 
easier to configure than the Network Shared printing method. For more information, see Network Shared 
printing on page 208.

 Each computer must use the TCP/IP Protocol.

 Your P-touch labeling system needs an appropriate IP address configuration.

 If using a router, you must configure the Gateway address on the computers and your P-touch labeling 
system.

TCP/IPTCP/IP
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Network Shared printing 28

In a Network Shared environment, each computer sends data via a centrally controlled computer. This type 
of computer is often called a “Server” or a “Print Server”. Its job is to control the printing of all print jobs.

 In a larger network, we recommend using a Network Shared printing environment.

 The “server” or the “print server” must use the TCP/IP print protocol.

 Your P-touch labeling system needs to have an appropriate IP address configuration, except when the 
P-touch labeling system is connected via the USB interface to the server.

 

1 Client computers

2 Also known as “Server” or “Print server”

3 TCP/IP or USB

Network printer 
(your P-touch labeling system)
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Configuring Your P-touch Labeling System for a Network 28

IP Addresses, Subnet Masks and Gateways 28

To use the P-touch labeling system in a networked TCP/IP environment, you must configure its IP address 
and subnet mask. The IP address you assign to the print server must be on the same logical network as your 
host computers. If it is not, you must correctly configure the subnet mask and the gateway address.

IP address 28

An IP address is a series of numbers that identifies each device connected to a network. An IP address 
consists of four numbers separated by dots. Each number is between 0 and 254.

 For example in a small network, you would normally change the final number:

• 192.168.1.1

• 192.168.1.2

• 192.168.1.3

How the IP address is assigned to your print server: 28

If you have a DHCP/BOOTP/RARP server on your network, the print server will automatically obtain its IP 
address from that server.

Note
On smaller networks, the DHCP server may also be the router.

 

If you do not have a DHCP/BOOTP/RARP server, the Automatic Private IP Addressing (APIPA) protocol will 
automatically assign an IP address from the range 169.254.0.1 to 169.254.254.254. The subnet mask is 
automatically set to 255.255.0.0 and the gateway address is set to 0.0.0.0.

By default, the APIPA protocol is enabled. To disable the APIPA protocol, use BRAdmin Light or Web Based 
Management (web browser).
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Subnet mask 28

Subnet masks restrict network communication.

 For example, Computer 1 can communicate with to Computer 2

• Computer 1

IP Address: 192.168.1.2

Subnet Mask: 255.255.255.0

• Computer 2

IP Address: 192.168.1.3

Subnet Mask: 255.255.255.0

The 0 in the Subnet mask signifies that there is no limit to communication at this part of the address. In the 
example above this means that you can communicate with any device with an IP address that begins with 
192.168.1.x. (where x is a number between 0 and 254).

Gateway (and router) 28

A gateway is a network point that acts as an entrance to another network and sends data transmitted via the 
network to an exact destination. The router knows where to direct data that arrives at the gateway. If a 
destination is located on an external network, the router transmits data to the external network. If your network 
communicates with other networks, you may need to configure the Gateway IP address. If you do not know 
the Gateway IP address contact your network administrator.
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Wireless Network Terms and Concepts 28

Security Terms 28

Authentication and encryption 28

Most wireless networks use some kind of security settings. These security settings define the authentication 
(how the device identifies itself to the network) and encryption (how the data is encrypted as it is sent on the 
network). If you do not correctly specify these options when you are configuring your Brother wireless 
printer, it will not be able to connect to the wireless network. Make sure you configure these options 
carefully.

Authentication and Encryption methods for a personal wireless network 28

A personal wireless network is a small network, for example using your P-touch labeling system in a wireless 
network at home, without IEEE 802.1x support.

To use your P-touch labeling system in an IEEE 802.1x supported wireless network, see Authentication and 
Encryption methods for an enterprise wireless network on page 213.

Authentication methods 28

 Open system

Wireless devices are allowed to access the network without any authentication.

 Shared key

A secret pre-determined key is shared by all devices that will access the wireless network.

The Brother wireless printer uses a WEP key as the pre-determined key.

WPA-PSK

Enables a Wi-Fi Protected Access Pre-shared key (WPA-PSK), which enables the Brother wireless printer 
to associate with access points using TKIP for WPA-PSK.

WPA2-PSK

Enables a Wi-Fi Protected Access Pre-shared key (WPA2-PSK), which enables the Brother wireless 
printer to associate with access points using AES for WPA2-PSK (WPA-Personal).

WPA/WPA2-PSK

Enables a Wireless Protected Access Pre-shared key (WPA-PSK/WPA2-PSK), which enables the Brother 
wireless printer to associate with access points using TKIP for WPA-PSK or AES for WPA-PSK and 
WPA2-PSK (WPA-Personal).

Encryption methods 28

 None

No encryption method is used.

WEP

When using WEP (Wired Equivalent Privacy), the data is transmitted and received with a secure key.
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 TKIP

TKIP (Temporal Key Integrity Protocol) provides per-packet key mixing, a message integrity check and 
rekeying mechanism.

 AES

Advanced Encryption Standard (AES) provides stronger data protection using a symmetric-key 
encryption.

Network key 28

 Open system/Shared key with WEP

This key is a 64-bit or 128-bit value that must be entered in an ASCII or hexadecimal format.

• 64 (40) bit ASCII:

Uses five text characters. For example, “WSLAN” (case-sensitive)

• 64 (40) bit hexadecimal:

Uses 10 digits of hexadecimal data. For example, “71f2234aba”

• 128 (104) bit ASCII:

Uses 13 text characters. For example, “Wirelesscomms” (case-sensitive)

• 128 (104) bit hexadecimal:

Uses 26 digits of hexadecimal data. For example, “71f2234ab56cd709e5412aa2ba”

WPA-PSK/WPA2-PSK and TKIP or AES, WPA2 with AES

Uses a Pre-Shared Key (PSK) that is eight or more characters in length, up to a maximum of 63 
characters.

When Communication Mode is set to Ad-hoc

Authentication Method Encryption Mode

Open System None

WEP

When Communication Mode is set to Infrastructure

Authentication Method Encryption Mode

Open System None

WEP

Public Key Authentication WEP

WPA-PSK TKIP

WPA2-PSK AES

WPA/WPA2-PSK TKIP

AES



Network Terms and Information 

213

28

Authentication and Encryption methods for an enterprise wireless network 28

An enterprise wireless network is a large network with IEEE802.1x support. If you configure your P-touch 
labeling system in an IEEE802.1x supported wireless network, you can use the following authentication and 
encryption methods:

Authentication methods 28

 LEAP (For wireless network)

Cisco LEAP (Light Extensible Authentication Protocol) has been developed by Cisco Systems, Inc. and 
uses a user ID and password for authentication.

 EAP-FAST

EAP-FAST (Extensible Authentication Protocol-Flexible Authentication via Secured Tunnel) has been 
developed by Cisco Systems, Inc. and uses a user ID and password for authentication, and symmetric key 
algorithms to achieve a tunnelled authentication process.

The printer supports the following inner authentication methods:

• EAP-FAST/NONE

• EAP-FAST/MS-CHAPv2

• EAP-FAST/GTC

 PEAP

PEAP (Protected Extensible Authentication Protocol) has been developed by Microsoft Corporation, Cisco 
Systems and RSA Security. PEAP creates an encrypted SSL (Secure Sockets Layer)/TLS (Transport 
Layer Security) tunnel between a client and an authentication server, for sending a user ID and password. 
PEAP provides mutual authentication between the server and the client.

The printer supports the following inner authentication methods:

• PEAP/MS-CHAPv2

• PEAP/GTC

 EAP-TTLS

EAP-TTLS (Extensible Authentication Protocol Tunnelled Transport Layer Security) has been developed 
by Funk Software and Certicom. EAP-TTLS creates a similar encrypt SSL tunnel to PEAP, between a 
client and an authentication server, for sending a user ID and password. EAP-TTLS provides mutual 
authentication between the server and the client.

The printer supports the following inner authentication methods:

• EAP-TTLS/CHAP

• EAP-TTLS/MS-CHAP

• EAP-TTLS/MS-CHAPv2

• EAP-TTLS/PAP

 EAP-TLS

EAP-TLS (Extensible Authentication Protocol Transport Layer Security) requires digital certificate 
authentication both at a client and an authentication server.
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Encryption methods 28

 TKIP

TKIP (Temporal Key Integrity Protocol) provides a per-packet key mixing a message integrity check and 
rekeying mechanism.

 AES

Advanced Encryption Standard (AES) provides stronger data protection using a symmetric-key 
encryption.

 CKIP

The original Key Integrity Protocol for LEAP by Cisco Systems, Inc.

When Communication Mode is set to Infrastructure

Authentication Method Encryption Mode

LEAP CKIP

EAP-FAST/NONE TKIP

AES

EAP-FAST/MS-CHAPv2 TKIP

AES

EAP-FAST/GTC TKIP

AES

PEAP/MS-CHAPv2 TKIP

AES

PEAP/GTC TKIP

AES

EAP-TTLS/CHAP TKIP

AES

EAP-TTLS/MS-CHAP TKIP

AES

EAP-TTLS/MS-CHAPv2 TKIP

AES

EAP-TTLS/PAP TKIP

AES

EAP-TLS TKIP

AES
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User ID and password 28

The following security methods support a user ID less than 64 characters and a password less than 32 
characters in length:

 LEAP

 EAP-FAST

 PEAP

 EAP-TTLS

 EAP-TLS (For user ID)
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29

Symbols 29

Symbols/Characters/Styles 29

Category Symbols

Punctuation

Datacom

Audio/Visual

Electrical

Arrows

Safety

Prohibited

Brackets

Mathematics

Greek

Super/Subscript
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Note
The symbols shown in the table may look slightly different on the P-touch labeling system LCD and when 
printed.

 

Bullets

Currency

Misc.

Category Symbols
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Accented Characters 29

Character Accented Characters Character Accented Characters

a n

A N

c o

C O

d r

D R

e s

E S

g t

G T

i u

I U

k y

K Y

l z

L Z
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Character Attributes 29

Note
• Factory settings are shown in bold.

• The actual printed font size depends on the tape width, number of characters and number of input lines. 
When characters reach a minimum size, the selected font will be changed to a default custom font, which 
is based on the Helsinki style. This allows labels using the smallest text possible on narrow or multi-line 
labels.

• If 4 point or 5 point is selected for the font size, the text is printed in the Brussels font regardless of the 
selected font.

 

1 The default font for labels.
2 The default font for cable labels.

Attribute Value Result Value Result

Font

Helsinki 1 Belgium

Brussels Atlanta

US Adams

Los 
Angeles

Brunei

San Diego Sofia

Florida Germany

Calgary
Letter 
Gothic 2
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Attribute Value Result Value Result

Size Auto
When Auto is selected, the text is 
automatically adjusted to print in the 
largest size available for each tape 
width.

4-90 pt
The character is fixed to the selected 
size.

Width

x 2

 

x 2/3

 

x 3/2

 

x 1/2

 

x 1
 

Style

Normal
 

I + Bold

 

Bold

 

I + 
Outline

 

Outline

 

I + 
Shadow

 

Shadow

 

I + Solid

 

Solid

 

Vertical

Italic

 

Vertical+
Bold

Line

Off
 

Underline

 

Strike 
out
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Alignment

Left
 

Right

 

Center

 

Justify

 

Attribute Value Result Value Result
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Frames 29

Value Result Value Result Value Result

1 2 3

4 5 6

7 8 9

10 11 12

13 14 15

16 17 18

19 20 21

22 23 24

25 26 27

28 29 30

31 32 33

34 35 36

37 38 39

40 41 42

43 44 45

46 47 48
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49 50 51

52 53 54

55 56 57

58 59 60

61 62 63

64 65 66

67 68 69

70 71 72

73 74 75

76 77 78

79 80 81

82 83 84

85 86 87

88 89 90

91 92 93

94 95 96

97 98 99

Value Result Value Result Value Result
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Auto Format 29

Templates 29

Category Value Size Label layout

Asset Management

Asset Tag 1
1.4" x 2.7" 

(36 mm x 70 mm)

Asset Tag 2
0.94" x 2.7" 

 (24 mm x 70 mm)

Asset Tag 3
0.70" x 2.7" 

(18 mm x 70 mm)

Bin Box 1
1.4" x 3.0" 

(36 mm x 76 mm)

Bin Box 2
0.94" x 3.0" 

(24 mm x 76 mm)

Bin Box 3
0.70" x 3.0" 

(18 mm x 76 mm)

Equipment Label 1
1.4" x 2.2" 

(36 mm x 58 mm)

Equipment Label 2
0.94" x 2.2" 

(24 mm x 58 mm)

Equipment Label 3
0.70" x 2.2" 

(18 mm x 58 mm)
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Cabinet

Cabinet Label 1
1.4" x 4.9" 

(36 mm x 126 mm)

Cabinet Label 2
0.94" x 4.9" 

(24 mm x 126 mm)

Cabinet Label 3
0.70" x 4.3" 

(18 mm x 111 mm)

Cabinet Label 4
0.70" x 4.3" 

(18 mm x 111 mm)

Cabinet Label 5
1.4" x 6.2" 

(36 mm x 160 mm)

Cabinet Label 6
0.94" x 6.2" 

(24 mm x 160 mm)

Signage

Signage 1
1.44" x 4.9" 

(36 mm x 126 mm)

Signage 2
0.94" x 4.9" 

(24 mm x 126 mm)

Signage 3
1.44" x 2.5" 

(36 mm x 66 mm)

Signage 4
0.94" x 2.5" 

(24 mm x 66 mm)

File

Binder Spine 1
1.44" x 8.6" 

(36 mm x 219 mm)

Binder Spine 2
0.94" x 8.6" 

(24 mm x 219 mm)

Binder Spine 3
0.70" x 8.6" 

(18 mm x 219 mm)

File Folder Tab
0.47" x 3.2" 

(12 mm x 82 mm)

Divider Tab
0.47" x 1.6" 

(12 mm x 42 mm)

Category Value Size Label layout
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Address/ID

Address Label 1
1.44" x 2.7" 

(36 mm x 70 mm)

Address Label 2
0.94" x 2.7" 

(24 mm x 70 mm)

Address Label 3
0.70" x 2.7" 

(18 mm x 70 mm)

Name Badge 1
1.44" x 2.8" 

(36 mm x 72 mm)

Name Badge 2
0.94" x 2.8" 

(24 mm x 72 mm)

Name Badge 3
0.70" x 2.8" 

(18 mm x 72 mm)

Name Badge 4
0.70" x 2.8" 

(18 mm x 72 mm)

Media

SD Card Label
0.47" x 0.90" 
(12 mm x 25 mm)

USB Flash Memory
0.35" x 0.90" 
(9 mm x 25 mm)

CD Case Spine 1
0.23" x 4.4" 

(6 mm x 113 mm)

CD Case Spine 2
0.13" x 4.4" 

(3.5 mm x 113 mm)

Category Value Size Label layout
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Block Layouts 29

Attribute Value Details Value Details

1.44" 
(36 mm)

2LineA 1+2LineB

2LineB 1+3Line

3Line 1+4Line

1+2LineA 1+5Line

0.94" 
(24 mm)

2LineA 1+2LineB

2LineB 1+3Line

3Line 1+4Line

1+2LineA 1+5Line

0.70" 
(18 mm)

2LineA 1+2LineB

2LineB 1+3Line

3Line 1+4Line

1+2LineA 1+5Line

0.47" 
(12 mm)

2LineA 3Line

2LineB 1+2Line
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0.35" 
(9 mm)

2LineA 1+2Line

2LineB

0.23" 
(6 mm)

1+2Line

Attribute Value Details Value Details



Symbols/Characters/Styles 

229

29

Barcodes 29

Barcode Settings 29

Note
Factory settings are shown in bold.

 

Special Characters 29

Attribute Value

Protocol
CODE39, CODE128, EAN-8, EAN-13, GS1-128 (UCC/EAN-128), UPC-A, 

UPC-E, I-2/5 (ITF), CODABAR

Width
Small
Large

Under# 
(characters printed below barcode)

On
Off

C.Digit 
(check digit)

Off
On 

(available only for the CODE39, I-2/5, and CODABAR protocols)

CODE39

Special Character

(SPACE)

CODABAR

Special Character
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CODE128, GS1-128 (UCC / EAN-128)

Special Character

(SPACE) DC3

DC4

NAK

SYN

NUL ETB

CAN

SOH EM

STX SUB

ETX ESC

EOT

ENQ FS

ACK

BEL GS

BS

HT RS

LF

VT US

FF DEL

CR FNC3

SO FNC2

SI FNC4

DLE FNC1

DC1

DC2
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Time and Date 29

Time and Date Format Options 29

Note
Factory settings are shown in bold.

 

Attribute Value

Date 12/31/2099 2099-12-31

12.31.2099 31/12/2099

12-31-2099 31.12.2099

December 31, 2099 31-12-2099

Dec. 31, 2099 31. December 2099

2099/12/31 31. Dec. 2099

Time 11:59 PM 23:59
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